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Important Information About Your Projector

Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes. Never
let children look into the lens when it is on. Never open any cover on the projector, except the lamp and filter covers.
Dangerous electrical voltages inside the projector can severely injure you. Except as specifically explained in this User’s
Guide, do not attempt to service this product yourself. Refer all servicing to qualified service personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small children
to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by the
oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Remote Control Information

You can operate the projector by remote control via a line-of-sight infrared (IR) receiver at the front and rear of
the projector. The projector may not respond to remote control commands under the following conditions:

There is an object between the remote control IR emitter and the IR receiver on the projector.
Ambient light is too bright.

Certain types of fluorescent lighting are used.

A strong light source shines into the IR receiver.

Other equipment that emits infrared energy, such as a radiant room heater, is in the room.

o o oo d

These conditions commonly cause problems for most infrared-controlled equipment. Try the following:

The remote control unit’s batteries may be low on power; replace them.

Dim the ambient lighting and/or turn off any fluorescent lights.

Close any window coverings and/or move the projector out of direct sunlight.
Turn off other equipment that emits infrared energy.

o o o o

If the remote control still does not work properly, remember you can always control your computer-based

L Jtatien divegtly. drem the computer, even in an environment containing one of the conditions listed above.



FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio or television reception.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause interference to radio and television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the following measures.

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

o o o o

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification of this device and may cause interference levels which exceed the limits established by the FCC for
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this
device. If this equipment has more than one interface connector, do not leave cables connected to unused
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority
to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement sur le materiel brouilleur du
Canada.
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Introduction
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Your EPSON® PowerLite® projector is a brilliant, lightweight,
portable projector that allows you to project full-color images and
video onto a large screen for presentations. You can connect it
simultaneously to three image sources: two computers or workstation
sources, plus one video source, such asa VCR, DVD player,
camcorder, or digital camera. You can also connect audio for each
image source.

Images are displayed in full color (16,770,000 colors) at an SVGA
resolution of 800 x 600 pixels on the PowerLite 5350, and an XGA
resolution of 1024 x 768 pixels on the PowerLite 7250 and 7350. The
projectors support a wide variety of video inputs, from VGA to UXGA
with resolutions up to 1600 x 1200. It produces bright images that can
be easily seen in rooms light enough to take notes.

DLP.com



Your projector’s two speakers employ a built-in SRS 3D Sound System
for rich, powerful audio output. You can even connect an external
speaker when further amplification is required.

For your presentations, you can select front, rear, or ceiling projection.
This provides maximum flexibility in choosing the best display
method for each environment.

You control your projector through a hand-held remote control unit,
with menus provided for image source switching and image
adjustment. The remote control can also act as a wireless mouse to
control operations on your computer screen during presentations.
Additionally, you can install the projector’s ELP Link IV software to
control the projector’s settings from your computer and enhance your
presentations with special effects.

Your projector features a new patented SizeWise™ chip for support of
SVGA, UGA, XGA, and SXGA (PowerLite 5350), and XGA, VGA,
SXGA and UXGA (PowerLite 7250 and 7350) output. No matter
what type of computer output is used, the result is a full-size video
image of outstanding clarity.

The projector supports a wide range of computers and workstations:
IBM® compatible PCs and laptops, Apple® Macintosh® Power
Macintosh;" Power Macintosh G3" iMac," and PowerBook®
computers, and workstations such as the Sun® SPARCstation.™
(The PowerLite 5350 is not recommended for use with high-end
workstations). The video source can be HDTV, NTSC, PAL, or
SECAM. The projector automatically senses the video format, which
4 FixYourDLE&bRE composite video, S-Video, or component video. See Chapter 7
4 ““for'details on supported computers and video formats.
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Getting the Most Out of Your Projector

Your projector comes with a full set of features that enable you to
control the settings for the image display, video, and audio. To get the
most out of the projector, read this section for a quick summary of the
important features.

Remote Control

The buttons on the remote control allow you to turn the projector on
and off, and provide direct access to zoom, freeze, volume, mute, and
image source switching. Use the remote control buttons to access
custom functions and the projector’s menu system. You can also use
the remote control to control your computer in place of your
computer’s mouse.

Sleep Mode

Sleep mode conserves electricity by automatically turning off the lamp
after the projector has not been used for 30 minutes. In sleep mode,
the projector remains on but the lamp is turned off, conserving
electricity, cooling the projector, and extending the life of the lamp.
To return to normal operation, press the Power button.

Online Help

Extensive online help is available for operating the projector and
working in the projector’s feature menus. You can display the help at
any time by pressing the Help button on either the control panel or

. FixYourDLP.comine remote control.
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Optional Accessories

To enhance your use of the projector, EPSON provides the following:

Product Product Number

Customized carrying cases for the projector and its cables:

Hard shell carrying case (small) ELPKS17
Soft carrying case ELPKS10
ATA Shipping Case ELPKS19
Laptop/projector softcase with wheels and ELPKS18

retractable handle

Replacement lamp and air filter ELPLPO9
Long throw zoom lens ELPLLO1
Wide convergence lens ELPCWO1

Communication kit cable set and computer cable so you can connect your
projector to a second computer. There is also a Mac® adapter set so you can
connect to a second Macintosh. You may also need the VGA-13W3 video
cable if you're connecting the projector to a high-end workstation.

ELP communication cable set ELPKC17
Computer video cable ELPKCO02
(HD15/H15, 1.8m)

Computer video cable ELPKCO09

(HD15/HD15, 3.0m)
4 FixYourDLP.com
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Product Product Number

Portable projection screen ELPSCO06
Remote control receiver module ELPSTO02
Mediaphile™ PAS ELPPAS1

(personal audio system)

Mediaphile CVS ELPCVS1
(clean voice system, wireless
microphone and satellite speakers)

You can purchase these accessories from your dealer or by calling
EPSON Accessories at (800) 873-7766; or visit our web site at
www.epsonsupplies.com (U.S. sales only). In Canada, please call
(800) 873-7766 for dealer referral.

4 FixYourDLP.com
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About This Guide

k
=

This guide describes how to set up and use the EPSON

PowerLite 5350, PowerLite 7250, and PowerLite 7350 projectors.
The instructions pertain to all these models, except where otherwise
noted.

Chapter 1, “Setting Up the Projector,” provides step-by-step
instructions on how to set up your projector; connect it to your
computer, video source, or other optional equipment; and turn it on.

Chapter 2, “Using the Projector,” explains how to position the
projector relative to the screen, focus and position the screen image,
control the projector using the remote control and the control panel,
and monitor the projector’s operating status.

Chapter 3, “Using the Projector Menus,” describes how to use the
projector’s built-in menus to adjust the color and image settings,
change the display of the projected image, set and adjust various
projector options, and modify audio settings such as bass and treble.

Chapter 4, “Using ELP Link 1V,” explains how to use the ELP Link IV
software to control the projector settings from the computer and use
the special effects functions.

Chapter 5, “Maintenance,” covers basic procedures for maintaining
your projector in good working order and gives guidelines for
transporting it.

Chapter 6, “Troubleshooting,” describes how to interpret your

JFixYourDLfisjettor’s warning lights and gives helpful information for avoiding

errors, optimizing image quality, and solving.problems.
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Chapter 7, “Technical Specifications,” lists the technical specifications
for the projector.

A Glossary and Index are provided at the end of the manual.

Where to Get Help

If you are having trouble setting up or running your projector, first see
Chapter 6, “Troubleshooting.” If you cannot resolve the problem,
EPSON provides technical assistance through electronic support
services and automated telephone services 24 hours a day. The
following tables list the contact information.

Electronic Support Services

ke« FixYour

4

Service

Access

World Wide Web

EPSON Internet FTP Site

EPSON Forum on
CompuServe®

From the Internet, you can reach EPSON’s Home
Page at http://www.epson.com.

If you have Internet FTP capability, use your Web
browser (or other software for FTP downloading) to
log onto ftp.epson.com with the user name
anonymous and your e-mail address as the password.

Members of CompuServe can type GO EPSON at the
menu prompt to reach the Epson America Forum.

For a free introductory CompuServe membership, call
(800) 848-8199 and ask for representative #529.

DLP.com
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Automated Telephone Services

Service Access

EPSON SoundAdvices™ For pre-recorded answers to commonly asked
questions about EPSON products 24 hours a day,
seven days a week, call (800) 922-8911.

EPSON FaxAdvice™ Access EPSON'’s technical information library by
calling (800) 922-8911. You must provide a return fax
number to use this service.

EPSON Referral Service For the location of your nearest Authorized EPSON
Reseller or Customer Care Center, call (800)
922-8911.

When you need support, follow the calling instructions on the back
of the EPSON Private Line Technical Support card included with
the projector. Technical support is also available by calling

(310) 974-1202 between 6 AM and 6 PM, Pacific Time, Monday
through Friday. Toll or long distance charges may apply.

Before you call, please have the following information ready:

O Product name
0 Product serial number

0 Personal identification number (PIN) for EPSON Private Line
Technical Support

0 Computer configuration
. FixYourDLBComeseription of the problem

8 Introduction



You can purchase accessories from EPSON Accessories at

(800) 873-7766, or visit our web site at www.epsonsupplies.com
(U.S. sales only). In Canada, please call (800) 873-7766 for dealer
referral.

Safety Instructions

Follow these safety instructions when setting up and using the
projector:

1. Do not place the projector on an unstable cart, stand, or table.
2. Do not use the projector near water or sources of heat.

3. Use attachments only as recommended.
4

Use the type of power source indicated on the projector. If you are
not sure of the power available, consult your dealer or power
company.

5. Place the projector near a wall outlet where the plug can be easily
unplugged.

Placez le projecteur pres d’une prise de contacte ou la fiche peut étre
débranchée facilement.

6. Insert the projector’s three-wire grounding-type plug into a
properly grounded outlet. If you have a two-prong outlet, contact
an electrician to replace it. Do not hold the plug with wet hands.

7. Take the following precautions for the plug. Failure to comply

%/ FixYourDLP.com  \yith these precautions could result in sparks or fire.
0¢"Do not insert the plug into an-outlet with dust-present:
U R Inserbtheyptag ficmiyrinto the©utlet

Safety Instructions



10.

11.

12.

13.

14.

15.

16.

L
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Do not overload wall outlets, extension cords, or integral
convenience receptacles. This can cause fire or electric shock.

Do not place the projector where the cord can be walked on. This
may result in fraying or damage to the plug.

Unplug the projector from the wall outlet before cleaning. Use a
damp cloth for cleaning. Do not use liquid or aerosol cleaners.

Do not block the slots and openings in the projector case. They
provide ventilation and prevent the projector from overheating.
Do not operate the projector on a sofa, rug, or other soft surface,
or in a closed-in cabinet unless proper ventilation is provided.

Never push objects of any kind through cabinet slots. Never spill
liquid of any kind into the projector.

Except as specifically explained in this User’s Guide, do not
attempt to service this product yourself. Refer all servicing to
qualified service personnel. Opening or removing covers may
expose you to dangerous voltages and other hazards.

Unplug the projector during lightning storms or when it will not
be used for extended periods.

Do not place the projector and remote control on top of
heat-producing equipment or in a heated place, such as a car.

Unplug the projector from the wall outlet and refer servicing to
qualified service personnel under the following conditions:

0 When the power cord or plug is damaged or frayed

If liquid has been spilled into the projector, or if it has been
exposed to rain. or. water

10 Introduction
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If it does not operate normally when you follow the operating
instructions, or if it exhibits a distinct change in performance,
indicating a need for service

If it has been dropped or the housing has been damaged.

Safety Instructions
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Setting Up the Projector

T his chapter describes how to unpack your projector, connect it to
other equipment, and turn everything on. The projector must be
connected to a computer or a video source such as a VCR, camcorder,
digital camera, or laser disc player before it can project any images.
You may also want to set up the projector for one or more of the
following:

0O Connect the mouse cable to use the remote control as a wireless
mouse. Except for some laptops, this disables your computer’s
mouse. If you are also viewing the display on your monitor, you
use the remote control’s pointer to control the screen cursor.

.4 FixyourDLP.com( Provide audio for one or both image sources. The audio source can
= e be the computer, video source, or another device such as a stereo.

(07 “Connect to'an external-speaker'or PA system to amplify the audio.

13
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Unpacking the Projector

When you unpack the projector, make sure you have all these
components:

Projector

O Remote control

O 2 AA batteries

O Power cord

O Projector video cable

O Audio cable

O Audio/video (A/V) cable

k% FixYourDLP.com
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Macintosh adapter set:
Macintosh desktop adapter

Macintosh monitor adapter

Main cable (for connecting a mouse cable to
use the remote as a wireless mouse and/or a
serial cable to use the ELP Link IV software)
PS/2® mouse cable (for the PC)

USB cable

Serial mouse cable (for the PC)

Mac mouse cable (for the Macintosh)

PC serial cable

Unpacking the Projector

15



Macintosh serial cable

Projector Software CD ROM

You will not need all these components; your configuration will
determine which ones you need.

Save all packaging in case you need to ship the projector in the future.
Always transport the projector in its original packaging (or the
equivalent), or use a carrying case if you are carrying the projector by
hand. (See page 141 for instructions.)

Additional Components

16

Depending on how you plan to use the projector, you may need
additional components:

O To receive an S-Video signal, you need an S-Video cable. (One is
usually provided with your video device.) A separate cable is
required for each video source.

O To connect a second computer, you need a computer video and
audio cable.

4 FixYourDLP.com
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O To connect the projector to a Macintosh PowerBook, you may
need a video-out cable. (One is provided by—or can be purchased
from—Apple for all new PowerBooks that have video-out
capability.) If your PowerBook does not include one, see your
Macintosh dealer.

O You can not currently use the ELP Link IV software with a Power
Macintosh G3 or iMac. Check with your dealer for future support.

O To connect the projector to an external sound system, you need an
RCA-t0-3.5 mm stereo audio cable. You can obtain one from your
computer dealer.

O To connect the mouse cable to your computer, you may require a
special connector, cable, or other components. You can obtain
these items from your computer dealer.

Note: You can connect a Kensington MicroSaver® anti-theft device in
the hole on the projector’s right side. Contact your computer dealer.

4 FixYourDLP.com
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Installing the Remote Control Batteries

You can use the remote control as a wireless mouse instead of your
computer’s mouse to control your presentation. You can also use it to
control the projector menus and use the Effects buttons.

Follow these steps to install the batteries in the remote control:

1. Slide off the battery compartment cover.

2. Insert the two AA batteries included with the projector. Make sure
the polarity of the batteries is correct.

4 FixYourDLP.com
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3. Replace the battery compartment cover.
When replacing batteries, take the following precautions:

0 Do not mix old and new batteries.

O Replace batteries as soon as they run out. If the batteries leak, wipe
away battery fluid with a soft cloth. If fluid gets on your hands,
wash them immediately.

O Remove batteries if you will not be using the projector for a long
period of time.

Before You Connect the Projector

Before you start connecting the projector to your equipment, decide
where you will want to place your projector and computer or video
source. The distance between the projector and the screen determines
the actual image size. Place the projector somewhere between 4 and
54.7 feet (1.2 and 16.7 meters) away from the screen; use the general
guidelines in the table below to determine the proper distance. (For
more precise calculations, see “Positioning the Projector” on page 62.)

Caution: Do not hold or lift the projector by the lens. This can damage the
lens.

4 FixYourDLP.com
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Horizontal distance from projector to screen

Image size (diagonal) Minimum Maximum

300 inches (10 m) 491.2 inches (12.5 m) 648.4 inches (16.5 m)
PowerLite 5350 488.2 inches (12.4 m) 656.3 inches (16.7 m)
200 inches (5.1 m) 326.7 inches (8.3 m) 433.0 inches (11.0 m)
PowerLite 5350 322.2 inches (8.2 m) 436.2 inches (11.1 m)
100 inches (2.54 m) 161.4 inches (4.1 m) 216.5 inches (5.5 m)
80 inches (2.03 m) 130.0 inches (3.3 m) 169.2 inches (4.3 m)
PowerLite 5350 - 172.9 inches (4.4 m)
60 inches (1.52 m) 94.3 inches (2.4 m) 125.9 inches (3.2 m)
PowerLite 5350 - 129.6 inches (3.3 m)
40 inches (1.02 m) 63.0 inches (1.6 m) 82.6 inches (2.1 m)
30 inches (0.76 m) 47.2 inches (1.2 m) 63.0 inches (1.6 m)

Be sure to place the projector on a sturdy, level surface within five feet
of the computer or video source.

4 FixYourDLP.com
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Connecting to a Computer

You can connect the projector to any computer capable of producing
standard VGA, Super VGA (SVGA), XGA, Super XGA (SXGA), or
UXGA (7350 and 7250 only) output, such as:

a
g
g

IBM compatible desktop PCs

IBM compatible laptop PCs

Apple Macintosh desktop computers, including Macintosh
Quadra® Macintosh Centris® Power Macintosh, Power
Macintosh G3, and iMac (a video-out port is not a standard iMac
feature, but can be purchased from a third party vendor)

Any Apple PowerBook with video-out capability

(PowerLite 7350 and 7250 only) Most high-end workstations
from Sun, Silicon Graphics® IBM, and Hewlett-Packard® (You
may need an adapter cable to connect to some high-end
workstations; see page 52.)

See the section that applies to your computer. Make sure both the
computer and projector are turned off before you start.

When you have finished connecting all your components, go to
page 57 to turn on the projector and equipment.

The illustration below identifies all the interface ports on the back of
the projector; you may want to refer to this as you connect your
computer or other equipment to the projector.

4 FixYourDLP.com
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Audio Out Audio 2 In

/ Mouse/Com 2
Rear IR Audio 1 In
Receiver
: I : : I Mouse/Com 1
[ I I
Repeater i i Computer 2
I I
I I
I I Computer 1
I I
I T
I I HD/Sync VD
1 1 S
I T L & R Audio In

S-Video In

Computer Out Composite Video In

A/C Powver Inlet
R/R-Y G/Y G Sync B/B-Y
Computer 2 or BNC Video Switch

Connecting to a PC Desktop Computer

To connect the projector to your PC desktop computer, you need to:

O Connect the projector video cable and computer monitor cable

0 Connect the mouse and/or serial cable (if you want to use the
remote control as a mouse or use the ELP Link 1V software)

0 Connect the audio cable (if you'll be projecting with audio)

Follow the steps in each section for the cables you need to connect.
- *F-x‘r'nurDLBsﬁme beginning, turn off the projector and computer if they are on.

Note: Computer configurationsvary.See your computer manual for the
location. of, the.ports, needed. to-connect. your projector.
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Connecting the Video and Monitor Cables

First connect the projector video cable and computer monitor cable.
Refer to this illustration while following the steps below.

Computer 1 port

Computer

monitor cable
Out port

4 FixYourDLP.com
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1. If you will be viewing the video on your computer monitor as well
as the projector screen, disconnect the monitor cable from the
video port on the back of your computer. Then connect the
monitor cable to the projector’s Computer Out port, as shown
below. (This is useful when you need to view the video output but
the projection screen is behind you.)

2. Connect one end of the projector video cable to the projector’s
Computer 1 port. (Use the Computer 2 port if you are
connecting a second computer.)

4 FixYourDLP.com
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3. Connect the other end of the projector video cable to the
computer’s video port.

4. Tighten the screws on all connectors.

Connecting the Mouse and Serial Cables

If you want to use the remote control as a mouse or use the ELP
Link 1V software, you need to connect the main cable. It provides
connectors for:

O The PS/2 mouse or USB cable (to use the remote control as a
mouse)

O The serial cable (to use the ELP Link IV software)

Refer to this illustration while following the steps below.

4 FixYourDLP.com
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main cable
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1. Connect the round end of the main cable to the projector’s

Mouse/Com 1 port. (Use the Mouse/Com 2 port if you are
connecting a second computer, and make sure the Computer
2/BNC video switch on the rear of the projector is set to the
Computer 2 position.)

To use the remote control as a wireless mouse, connect the PS/2
mouse or USB cable included with the projector to the MOUSE
terminal on the square end of the main cable.

Disconnect your mouse from the mouse port on the back of your
computer and replace it with the other end of the PS/2 mouse or
USB cable. (Your computer’s mouse will be disabled while you are
using the remote control as a mouse.)

DLP.com
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Note: If your system uses a serial mouse, perform steps 2 and 3 using
the PC mouse serial cable instead of the PS/2 mouse or USB cable (not
shown in the illustration).

4. Touse the ELP Link 1V software or to program new effects for the
Effects buttons on the remote control, connect one end of the
serial cable to the SERIAL terminal on the square end of the main
cable.

Connect the other end of the serial cable to the serial port on the
back of your computer.

Note: You will not be able to use ELP Link 1V software if your system
has only one serial port that is being used to support a serial mouse.

5. Tighten the screws on all connectors.

4 FixYourDLP.com
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Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio cable to
the Audio 1 jack on the projector. (Use the Audio 2 jack if you
are connecting a second computer.)

audio cable

2. Connect the other end of the audio cable to the speaker or audio
out port on the computer’s sound card.

4 FixYourDLP.com
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Connecting to a PC Laptop Computer

To connect the projector to your PC laptop computer, you need to:

0 Connect the projector video cable

0 Connect the mouse and/or serial cable (if you want to use the
remote control as a mouse or use the ELP Link IV software)

0 Connect the audio cable (if you'll be projecting with audio)

Follow the steps in each section for the cables you need to connect.
Before beginning, turn off the projector and computer if they are on.

Note: Laptop configurations vary. See your computer manual for the
location of the ports needed to connect your projector.

Connecting the Video Cable

First connect the projector’s video cable to your laptop.

Computer 1 port

. 1. Connect one end of the projector video cable to the projector’s
Lﬂi FixYourDLP.com  computer 1 port. (Use the Computer 2 port if you are
connecting a.second.computer.)
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2. Connect the other end of the video cable to the laptop’s video
(monitor) port.

3. Tighten the screws on all connectors.

Connecting the Mouse and Serial Cables

If you want to use the remote control as a mouse or use the ELP
Link 1V software, you need to connect the main cable. It provides
connectors for:

O The PS/2 or USB cable (to use the remote control as a mouse)
O The serial cable (to use the ELP Link IV software)

Refer to this illustration while following the steps below.

PS/2 or USB
cable

9-pin serial
cable

main cable

4 FixYourDLP.com
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Connect the round end of the main cable to the projector’s
Mouse/Com 1 port. (Use the Mouse/Com 2 port if you are
connecting a second computer, and make sure the Computer
2/BNC video switch on the rear of the projector is set to the
Computer 2 position.)

To use the remote control as a wireless mouse, connect the PS/2 or
USB cable included with the projector to the MOUSE terminal
on the square end of the main cable.

Connect the 6-pin (mini-DIN) end of the PS/2 mouse cable to the
external mouse port or connect the USB cable to the USB port on
your laptop.
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Note: If your laptop uses a serial mouse, perform steps 2 and 3 using
the PC serial mouse cable instead of the PS/2 or USB cable (not
shown in the illustration.)

4, To use the ELP Link IV software or to use the Effects buttons on
the remote control, connect one end of the serial cable to the
SERIAL terminal on the square end of the main cable.

5. Connect the other end of the serial cable to the serial port on the
back of your computer.

Note: You will not be able to use ELP Link IV software if your laptop
has only one serial port that is being used to support a serial mouse.

6. Configure your laptop to work with an external mouse.

Note: You may have to set the display to appear on both the laptop’s
screen and the projector. Some laptops let you change this setting with
the keyboard’s function keys or by using a setup utility provided by the
computer manufacturer. Check your laptop’s manual or online help
for instructions.

4 FixYourDLP.com
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Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio cable to
the Audio 1 jack on the projector. (Use the Audio 2 jack if you
are connecting a second computer.)

Audio 1 jack

[oeX NI

audio cable

2. Connect the other end of the audio cable to your laptop.

Note: PC audio cable jack locations vary. See your computer manual
for the location of the audio jack needed to connect your projector.

4 FixYourDLP.com
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Connecting to a Desktop Macintosh

To connect the projector to your desktop Macintosh, you need to:

O Connect the projector video cable and computer monitor cable

0 Connect the mouse and/or serial cable (if you want to use the
remote control as a mouse or use the ELP Link IV software)

0 Connect the audio cable (if you'll be projecting with audio)

Follow the steps in each section for the cables you need to connect.
Before beginning, turn off the projector and computer if they are on.

Notes:

0 Macintosh configurations vary. See your computer manual for the
location of the ports needed to connect your projector.

0O You can not currently use the ELP Link IV software with a Power
Macintosh G3 or iMac. Check with your dealer for future support.

4 FixYourDLP.com

4

34 1 « Setting Up the Projector



Connecting the Video and Monitor Cables

First connect the video and monitor cables. Refer to this illustration as
you follow the steps below.

Macintosh
desktop adapter

projector
video cable

Macintosh
monitor cable
monitor adapter

4 FixYourDLP.com
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1. Connect one end of the projector video cable to the projector’s
Computer 1 port. (Use the Computer 2 port if you are
connecting a second computer.)

2. Remove the small cover on the Macintosh desktop adapter (as
shown below) and set its DIP switches in accordance with the
resolution you want to use, such as 16-inch mode. See your
Macintosh documentation for instructions.

4 FixYourDLP.com
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3. Connect the small terminal of the Macintosh desktop adapter to
the other end of the projector video cable.

4. Disconnect the monitor cable from the video port on the back of
the Macintosh. Then connect the projector video cable (with the
Macintosh desktop adapter attached) to the video port on the
Macintosh.

4 FixYourDLP.com
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5. Toalso view the video on the computer’s monitor, attach the large
end of the Macintosh monitor adapter to the monitor cable and
connect the other end of the adapter to the projector’'s Computer
Out port.

6. Tighten the screws on all the connectors.

4 FixYourDLP.com
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Connecting the Mouse and Serial Cables

If you want to use the remote control as a mouse or use the ELP
Link IV software, you need to connect the main cable. It provides
connectors for:

0 The Mac mouse or USB cable (to use the remote control as a
mouse)

O The Mac serial cable (to use the ELP Link 1V software)

Refer to this illustration while following the steps below.

aac

Mouse/Com 1 port

Mac or USB
cable

" f Fix‘r’nur_DLﬁ.;_gm main cable

4
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1. Connect the small end of the main cable to the projector’s
Mouse/Com 1 port. (Use the Mouse/Com 2 port to connect a
second computer.)

2. To use the remote control as a wireless mouse, connect one end of
the projector’s Mac mouse or USB cable to the MOUSE terminal
on the large end of the main cable.

3. Disconnect your Macintosh’s mouse cable. Connect the other end
of the projector’s Mac mouse or USB cable to the mouse or USB

port on your Macintosh.
4 FixYourDLP.com
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4. Touse the ELP Link 1V software or to program new effects for the
Effects buttons on the remote control, connect one end of the Mac
serial cable to the Mac SERIAL terminal on the large end of the
main cable.

5. Connect the other end of the Mac serial cable to the & printer or
&% modem port on the back of your Macintosh.

4 FixYourDLP.com
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Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio cable to
the Audio 1 jack on the projector. (Use the Audio 2 jack if you
are connecting a second computer.)

Audio 1 jack

audio cable

2. Connect the other end of the audio cable to the audio-out port on
your computer.

4 FixYourDLP.com
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Connecting to a PowerBook
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Your PowerBook must have video-out capability in order to connect to
the projector.

To connect the projector to your PowerBook, you need to:

0 Connect the projector video cable

0 Connect the mouse and/or serial cable (if you want to use the
remote control as a mouse or use the ELP Link IV software)

0 Connect the audio cable (if you'll be projecting with audio)

Follow the steps in each section for the cables you need to connect.
Before beginning, turn off the projector and computer if they are on.

Note: PowerBook configurations vary, so the location of your computer’s
ports may not match the illustrations. See your PowerBook manual for the
port locations if necessary.

Connecting to a Computer
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Connecting the Video Cable

First connect the projector video cable. Refer to this illustration as you
follow the steps below.

video-out cable

000 /
Computer 1 % e
port N
Macintosh desktop

adapter

projector video cable

Note: Some new PowerBooks may allow you to connect the video cable
directly to the computer without using a video-out cable. See your
PowerBook manual for additional information on connecting a video
cable.

4 FixYourDLP.com
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1. Connect one end of the projector video cable to the projector’s
Computer 1 port. (Use the Computer 2 port if you are
connecting a second computer.)

2. Remove the small cover on the Macintosh desktop adapter and set
its DIP switches in accordance with the resolution you want to use
(such as 16-inch mode). See your Macintosh documentation for
instructions.

4 FixYourDLP.com
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3. Connect the small terminal of the Macintosh desktop adapter to
the other end of the video cable.

4. Connect the projector video cable (with the Macintosh desktop
adapter attached) to the video-out port on the PowerBook.

4 FixYourDLP.com
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If a video-out cable was provided with your PowerBook, connect

the smaller end of the video-out cable to the video-out port on the
back of the PowerBook. Connect the other end to the Macintosh

desktop adapter on the end of the projector video cable.

Connecting to a Computer

47



Connecting the Mouse and Serial Cables

If you want to use the remote control as a mouse or use the ELP
Link IV software, you need to connect the main cable. It provides
connectors for:

0 The Mac mouse or USB cable (to use the remote control as a
mouse)

O The Mac serial cable (to use the ELP Link 1V software)

Refer to this illustration while following the steps below.

Mac serial

Mouse/Com 1 port

Mac mouse or
USB cable

main cable

4 FixYourDLP.com
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1. Connect the round end of the main cable to the projector’s
Mouse/Com 1 port. (Use the Mouse/Com 2 port if you are
connecting a second computer, and make sure the Computer
2/BNC video switch on the rear of the projector is set to
Computer 2.)

2. To use the remote control as a wireless mouse, connect one end of
the projector’s Mac mouse or USB cable to the MOUSE terminal
on the large end of the main cable.

4 FixYourDLP.com
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3. Connect the other end of the Mac mouse or USB cable to the
mouse or USB port on the back of the PowerBook.

4. To use the ELP Link IV software or program new effects for the
Effects buttons on the remote control, connect one end of the Mac
serial cable to the MAC SERIAL terminal on the large end of the
main cable.

5. Connect the other end of the serial cable to the & printer/
@ modem port on the back of your PowerBook.
4 FixYourDLP.com
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Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio cable to
the Audio 1 jack on the projector. (Use the Audio 2 jack if you
are connecting a second computer.)

Audio 1 jack

audio cable

2. Connect the other end of the audio cable to the audio-out port on
your PowerBook.

Note: After you turn on the projector and computer, you'll need to choose
Mirroring in the Display Control Panel if you set up your configuration to
display on the LCD screen as well as the projector screen.

4 FixYourDLP.com
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Connecting to a High-End Workstation

The PowerLite 5350, 7250, and 7350 are capable of remapping input
resolutions up to 1280 x 1024 pixels. Since 1280 x 1024 pixels is the
default resolution for most leading workstations, this capability makes
these projectors the best portable solution for the display of
workstation video output.

There is no standard for workstation video output. Those workstations
that follow the SXGA standard and use the HD15 connector don’t
need an adapter cable.

Contact your audio/video dealer for information on connecting your
workstation.

Connecting to a Video Source

& 4 FixYourl
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You can connect a VCR, a camcorder, a laser disc player, DVD player,
or any other compatible video image source to your projector.

The projector can receive composite video, S-Video, or component
video. Your equipment has composite video if your video source has a
one-pin RCA video jack. Your equipment has S-Video if your video
source has a four-pin (mini-DIN) video jack. Your equipment has
component video if your video source has a three-connector (Y, R-Y,
B-Y) video jack.

Note: The projector is not compatible with a cable TV-style F connector.

DLP.com
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You can connect the projector to an S-Video source, a composite video
source, and a component video source at the same time. However, the
projector automatically selects the S-Video as the video source. To
display composite or component video, first disconnect the S-Video
source.

The projector supports HDTV, NTSC, PAL, and SECAM video
formats, and automatically detects and identifies the video format.
However, you can specify that a single broadcast format be detected.
(See Chapter 3.) Note that the projector will then be able to detect
only one type of video signal.

The type of cable you use to connect the video source to the projector
depends on whether you have composite video, S-Video, or
component video. For composite video, use the audio/video (A/V)
cable supplied with the projector. For S-Video, use the S-Video cable
supplied with your video device or obtain one from your computer or
video equipment dealer. For component video, use the BNC type
cable that came with your video source. The illustration below shows
the S-Video, component, and composite connectors.

S-Video component composite
4-pin, mini-DIN BNC connector RCA

1 2 77N

\‘/ M\

| | —
3/ = \A /

4 FixYourDLP.com
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To connect a video source to the projector:
1. Turn off the projector and video source if they are on.

2. If your video source uses a small, round, one-prong composite
(RCA) video connector, you'll need the audio/video cable that
comes with the projector. If your video source uses a large, round,
four-prong S-Video connector or a BNC type connector, you will
need to purchase the appropriate cable or use the cable that came
with your video source.

3. For composite video, connect the yellow RCA plug on one end of
the audio/video cable to the projector’s Video jack. Connect the
other yellow RCA plug to the video-out jack of your video source.

audio/video cable

4 FixYourDLP.com
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Connect the other plugs on the audio/video cable to the Audio
jacks of the projector: insert the white plug into the L jack and the
red plug into the R jack. Connect the plug at the other end of the
audio/video cable to the audio output jacks of the video source.

For S-Video, insert one end of an S-Video cable into the
projector’s S-Video connector. Insert the other end into the
S-video-out jack of your video source.

Ae

90
b)

X

S-Video connector
S-Video cable

For component video, insert three ends of a BNC cable into the
projector’'s R/R-Y, G/Y and B/B-Y jacks. Insert the opposite ends
of the cable into the Y/Video, C/R-Y, and B-Y jacks on your
component video source. (Don’t insert any of the cable ends into
the HD/Sync and VD jacks.)

Make sure the Computer 2/BNC switch is set to BNC.
Note:

O When the Computer 2/BNC switch is set to BNC, the projector is
unable to project the Computer 2 image signal.

O Use a standard BNC cable, which you can purchase from any
computer-store. The Computer 2/BNC videorcablessupplied:by
EPSON as an optional accessory does not work with component
video.
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Connecting to an External Speaker or
PA System

Although the projector’s internal speakers are enough for most small-
or medium-size rooms, you can connect the projector to an external
speaker or public address (PA) system for large rooms or to gain
maximum benefit from the projector’s built-in 3D sound function.

To connect the projector to an external sound system, you need to
obtain an RCA-t0-3.5 mm stereo audio cable. You can get one from
your computer dealer.

1. Turn off the projector and speaker or PA system if they are on.

2. Connect the cable’s 3.5 mm stereo miniplug to the projector’s
Audio Out jack.

Audio Out jack

stereo audio cable
4 FixYourDLP.com
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Note: EPSON offers the Mediaphile PAS (personal audio system) and
the Mediaphile CVS (clean voice system) for external amplification.
See page 5 for the part number and ordering information.

Connect the RCA plugs to the external amplified speaker or PA
system. Insert the cable’s red plug into the Audio R jack, and the
white plug into the Audio L jack.

Note: The internal speakers are disabled when an external audio
system is used.

Turning the Equipment On and Off

& 4 FixYourl
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It’s best to turn on the projector and its attached equipment in the
following order:

1.

2
3
4.
5

Video source (such as a VCR), if your video source is not your
computer

Audio source (if different from computer or video source)
Computer
External amplified speaker or PA system (if necessary)

Projector (follow the steps in the next section)

When you are ready to turn off the equipment, turn them off in the
reverse order.

DLP.com
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Turning the Projector On and Off

Follow these steps to turn on the projector:

1. Connect one end of the power cord to the projector’s power inlet.
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2. Connect the other end to a grounded electrical outlet. The power
light on the projector’s control panel turns orange, indicating that
the projector is in sleep mode. (The projector is not turned on
yet.)

3. Remove the projector lens cap.

4. Press the Power button on the remote control or control panel to
turn on the projector. The power light flashes green as the
projector warms up.

If computer or video equipment is attached, the computer or video
signal is projected. Allow about 30 seconds for full illumination.
4 FixYourDLP.com
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Warning: Never look into the lens when the lamp is on. This can damage
your eyes. It is especially important that children not look into the lens.

When you want to stop projecting images, press the Power button
again. The fan remains on and the projection lamp light flashes orange
for about 60 seconds as the projector cools down.When the projector
has cooled down, flashing stops. The power light remains orange.

Note: If you press the Power button to turn the projector back on while
the power light is orange, there may be a delay before a projected image
appears.

When you are done using the projector, unplug the power cord.

Never unplug the power cord when the power light is green; this may
damage the lamp.

Turning the Equipment On and Off
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Using the Projector

& { FixYour
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T his chapter provides the following information about using your

projector:

O Positioning the projector relative to the screen

O Focusing and positioning the screen image

O Resizing the projected image

O Sleep mode

0O Controlling the projector with the remote control and the control
panel

0 Monitoring the projector’s operating status

DLP.com
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The illustration below identifies the parts of your projector.

. . speaker
infrared receiver control panel p

status lights infrared receiver

speaker

foot adjust
lever
handle

adjustable feet
foot adjust lever

focus ring projection lens

zoom ring

Positioning the Projector

Your projector supports front, rear, and ceiling projection, allowing

you to choose the best method for displaying your images. If you use
«/|FixvourDLRRapror ceiling projection, you need to select this in the projector’s
e “Advanced menu. See page 97 for more information.
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To get the best results when projecting your images, it's important to
position the projector at the proper height and distance relative to the
screen.

When projecting from a table or desk, place the projector so the lens is
aligned as closely as possible with the bottom of your screen:

- ﬂ FixYou rDLP com
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When projecting from the ceiling, align the lens as closely as possible
with the top of your screen:

Using the Keystone Feature

In circumstances where the lens cannot be properly aligned, use the
projector’s Keystone function to help maintain optimum screen
geometry. This feature allows you to correct up to a + 20° tilt,
maintaining an aspect ratio of 4:3. Press the Keystone button on the
control panel to increase or decrease the image adjustment. Using the
ELP Link 1V software, you can correct up to a = 30° tilt. For more
information, refer to Chapter 3.

4 FixYourDLP.com
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Calculating Image Size and Projection Distance

& 4 FixYourl
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The distance between the projector and the screen determines the
actual image size. To determine the exact distance required for a
particular image size (or to determine the size of an image at a
particular distance), use the formulas given below. (Remember that
the size of the image can be changed by rotating the zoom ring; see

page 68 for more information.)

To determine the minimum and maximum diagonal size of an image
when you know the projection distance:

O

Inches:
Maximum diagonal size = (0.6124 x projection distance) + 1.5264
Minimum diagonal size = (0.4556 x projection distance) + 1.1410

Centimeters:
Maximum diagonal size = (0.6124 x projection distance) + 3.8771
Minimum diagonal size = (0.4556 x projection distance) + 2.8981

To determine the projection distance when you know the diagonal size
of the screen image:

O

O

DLP.com

Inches:
Maximum projection distance = (2.1949 x diagonal size) - 2.5044
Minimum projection distance = (1.6328 x diagonal size) - 2.4923

Centimeters:
Maximum projection distance = (2.1949 x diagonal size) - 6.3612
Minimum projection distance = (1.6328 x diagonal size) - 6.3304

Positioning the Projector
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For example, here are the measurements for three installations:

Horizontal distance from projector to screen

Image size (diagonal) Minimum Maximum

300 inches™* (762 cm) 487.3 inches (12.4 m) 656.0 inches (16.7 m)
200 inches (508 cm) 324.1 inches (8.2 m) 436.5 inches (11.1 m)
100 inches (254 cm) 160.8 inches (4.1 m) 217.1 inches (5.5 m)

* For an image size of 300 inches, the projector may be up to 54 feet away from
the screen, depending on the setting of the zoom ring.

Long Throw Zoom Lens Calculations

If you are using the optional long throw zoom lens, use the following
formulas instead:

To determine the minimum and maximum diagonal size of an image
when you know the projection distance:

O Inches:
Maximum diagonal size = (0.4742 x projection distance) + 3.2489
Minimum diagonal size = (0.2849 x projection distance) + 1.8968

0O Centimeters:
Maximum diagonal size = (1.2045 x projection distance) + 8.2522
Minimum diagonal size = (0.7236 x projection distance) + 4.8179

4 FixYourDLP.com
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To determine the projection distance when you know the diagonal size
of the screen image:

O

Inches:
Maximum projection distance = (3.5094 x diagonal size) - 6.6568
Minimum projection distance = (2.1090 x diagonal size) - 6.8519

Centimeters:
Maximum projection distance = (8.9139 x diagonal size) - 16.9083
Minimum projection distance = (5.3569 x diagonal size) - 17.4038

Fixed Wide Angle Lens Calculations

If you are using the optional fixed wide angle lens, use the following
formulas instead. To determine the minimum and maximum diagonal
size of an image when you know the projection distance:

ke« FixYour
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O

Inches:
Maximum diagonal size = (0.730 x projection distance) + 3.919
Minimum diagonal size = (0.616 x projection distance) + 3.050

Centimeters:
Maximum diagonal size = (1.8542 x projection distance) + 9.9542
Minimum diagonal size = (1.5646 x projection distance) + 7.7470

To determine the projection distance when you know the diagonal size
of the screen image:

O

DLP.com

Inches:
Maximum projection distance = (1.619 x diagonal size) - 4.702
Minimum projection distance = (1.367 x diagonal size) - 5.640

Centimeters:
Maximum projection distance = (4.1122 x diagonal size) - 11.9430
Minimum projection.distance = (3:4721 x diagonal size)'-'14.3256

Positioning the Projector
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Focusing and Positioning the Screen Image

When an image appears on screen, check that it is in focus and
correctly positioned on the screen. To focus the image, rotate the focus
ring (the inside ring on the lens). To adjust the size of the image, rotate
the zoom ring (the outside ring). Rotate the zoom ring clockwise to
make the screen image larger or counterclockwise to make it smaller.

zoom ring

focus ring

4 FixYourDLP.com
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If you need to raise or lower the image on the screen, extend or retract
the two feet at the bottom of the projector as follows:

1. Stand behind the projector and support the front of it while you
lift up on the foot adjust levers, located above the feet. This
unlocks the adjustable feet so they can move up and down. Don’t
let the projector drop.

Caution: Don't hold or lift the projector by its lens. This can damage
the lens.

2.  While lifting the levers, raise or lower the projector until the screen
image is correctly positioned.

3. Release the levers to lock the feet in their new position.

4. If you want to fine-tune the height of the projector, turn the
adjustable feet clockwise to raise the height, and counterclockwise
to lower the height.

v | FixYourDLP.comNote: You can also use the projector’s Keystone function to help get

-4 optimum screen geometry. Press the Keystone button on the control panel
to‘correct up-to'a+ 20° tilt, maintaining an-aspect ratio of 4:3."Using the
ELPLink-I\V/'software; you can correct-upto'a + 30%tilt.

Focusing and Positioning the Screen Image



Resizing the Projected Image

The Resize button lets you select the projection method for certain
types of image signals input from a computer. Press the Resize button
on the control panel or the remote control to select one of the
following projection methods for your projector.

PowerLite 5350:

With images less than SVGA (800 x 600), you can either display the
image in the center of the projection area or display it full size.

With images greater than SVGA size (up to 1024 x 768 pixels), you
can project the entire image in a compressed format. If you keep
pressing the Resize button, the projector will pan around areas of the
image. The projector automatically reduces the image size to the
projector’s maximum resolution.

Note: The Resize button cannot be used with images at SVGA
(800 x 600) resolution.

PowerLite 7250 and PowerLite 7350:

With images less than XGA (1024 x 768), you can either display the
image in the center of the projection area or display it full size.

With images greater than XGA size (up to 1600 x 1200 pixels), you
can project the entire image in a compressed format. If you keep
pressing the Resize button, the projector will pan around areas of the
image. The projector automatically reduces the image size to the

\FI.WDWDLBrGoJreA:tor’s maximum resolution.
ke 4 =

At “Note: The Resize button cannot be used with images at XGA
(10247« 768) resolution.
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Sleep Mode

Sleep mode conserves electricity by automatically turning off the lamp
after the projector has not been used for 30 minutes. In sleep mode,

the

projector’s power status indicator is orange and only a minimum

amount of the projector’s circuitry remains on. This conserves
electricity, cools the projector, and extends the life of the lamp. When
the projector is in sleep mode, you can press the Power button to start
projecting images, or you can unplug the projector’s power cord.

Controlling

the Projector

You can use the remote control or the control panel on top of the
projector to perform the following actions:

O
O
O

O O o g

4 FixYourDLP.comp,
g
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Turn the power on or off
Automatically set up the computer image

Switch between input images (Computer 1, Computer 2, or
Video)

Access the projector menus to adjust the image, audio, video, and
display settings

Resize the projected image

Freeze the display (remote control only)

Temporarily display a blank screen

Adjust or mute audio/video output

Use custom functions (remote control only)

Move the-mouse pointer. (remote-control only)

View-online help

Sleep Mode 71
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Using the Remote Control

IR Output

Freeze
AV Mute\ S e Power
\ E @//

Freeze

E-Zoom \
Crzoon( ) '*/C8EF2>— Remote

Special effects Control On/Off

buttons (1-5)

Enter (pointer) — |
button

llumination — |
Esc button —

battery cover \!

cover lock

/

4 FixYourDLP.com
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Additional remote control options are available by opening the cover
just below the Esc button:

RICON
oFF

Help

| BNC

S-Video e ||{ svieo  vigeo Video
- T

!

Auto Resize

Auto OH—— Resize
PinP Preset
I R
PinP - Volume + [ Preset
k
Volume

The remote control uses a line-of-sight infrared signal. To use the
remote control, point it towards one of the remote control receivers
located at the front and back of the projector. (See page 62.)

4 FixYourDLP.com
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You can use the remote control up to about 32.8 feet (10 meters) from
the projector. (This distance may be shorter if the remote control
batteries are low.) You must also be within a + 30° angle from the front
Or rear sensor.

Note: To be able to use the remote control as a wireless mouse, make sure
you've connected the mouse cable to the projector and your computer. (See
Chapter 1 for instructions.)

The five Special Effects buttons are preprogrammed with the
following options:

1 Change the mouse cursor to a stamp

2 Draw a box

3 Use a marker pen

4 Draw a freehand line

5 Clear the screen

For information on changing these special effects, refer to page 107.

The projector may not respond to remote control commands in these
conditions:

0 The RC (remote control) On/Off switch is in the Off position

O Batteries are weak

O Ambient light is too bright

O A certain type of fluorescent light is present

‘Fl.x,murmgmrﬁ strong light source (such as direct sunlight) shines into the
[ 4 b,

=" - infrared receiver

0. Other equipment emitting.infrared energy is present (suchasa
radiantreony heater):
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Correct these conditions to use the remote control or control the
projector from a computer.

The following table summarizes the remote control functions.

Button

Function

Power
Freeze

A/V Mute

E-Zoom

RC On/Off

Effects buttons

Enter
(Pointer button)

Illumination
Esc

4 FixYourDLP.com
Menpu

Starts or stops the projector.
Keeps the current computer or video image on the screen.

Turns off the audio and video, displaying either the black, blue or
user logo background.

Enlarges or reduces the image size from 1x to 4x. Pressing the
right side of the button enlarges the image, pressing the left side
of the button reduces the image. To display a portion of an
enlarged image which is outside of the display area, press the
Enter button and scroll the image to the desired location.

Turns the remote control on or off.

Use to display preprogrammed special effects. Additional effects
can be programmed using the ELP Link IV software, or control
panel menu options. (See page 107 for instructions.)

Use the Enter button to navigate the menus or use the remote as
a mouse pointer when the projector is connected to the computer
with the main cable and the mouse cable. When the image
source is Computer, the Enter button acts as a mouse left-click.

Illuminates all buttons on the remote control for 10 seconds.
Stops the current function. Pressing Esc while viewing a menu or
the online help displays the previous screen or menu. When the
image source is Computer, the Esc button acts as a mouse

right-click.

Displays-or-hides the.menu.

Controlling the Projector
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Button

Function

Compl
S-Video
Auto

PinP

Help
BNC
Video

Resize

Preset

| FixYourDLP.com, . .
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Switches to the Computer 1 image.
Switches to the S-Video image.
Optimizes the computer image.

Displays a video or S-video image in a subscreen on the main
display. Use the Enter button to reposition the Picture in Picture
(P in P) screen, or the E-Zoom button to enlarge or reduce the
image. Changes made to the P in P screen location and size are
automatically carried over to the next P in P session.

Displays the online help menu.
Switches to the Computer2/BNC image.
Switches to the Video image.

Switches the display dot mode and resize mode for VGA, XGA,
SVGA, and SXGA input. You cannot resize the image if the input
resolution matches the output resolution of the projector (SVGA
for the PowerLite 5350, or XGA for the PowerLite 7250 and
7350).

Saves and recalls up to five different session settings (resolution,
tracking, sync signal and position). To save the current session
settings, press the Preset button and it will be assigned the next
available number 1through 5. To recall a setting, press the Preset
button a second time and move to the desired session number.
To overwrite a saved setting, move to the setting you want to
replace and press Enter. When the confirmation message
displays, choose Yes and press Enter.

Adjusts the volume.

2 « Using the Projector



Using the Control Panel

b Power Help

Computer pAjmute Resize  Video

Sync-

- Keystone +

O C_O

Shift - Volume +

You can use the control panel to control the projector instead of the
remote control. However, you can only access the custom features
when you are using the remote control.

The following table summarizes the control panel functions.

Button Function
Power Starts or stops projection.
Help Displays the online help menu.

4 FixYourDLP.com
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Button

Function

Computer

A/V Mute

Resize

Video

Menu

Esc

Up, down arrows
(Sync+/Sync-)

Left, right arrows

(tracking-/
tracking+)

DLP.com

Switches between Computer 1 and Computer 2. (When the
Computer 2/BNC switch on the back of the projector is set to
BNC, the source is switched to 5BNC.)

Turns off the audio and video, displaying the black, blue, or user
logo background.

Switches the display dot mode and resize mode for VGA, XGA,
SVGA, and SXGA input. You cannot resize the image if the input
resolution matches the output resolution of the projector (SVGA
for the PowerLite 5350, or XGA for the PowerLite 7250 and
7350).

Switches to the video image. Pressing the button once switches
to composite video, pressing it twice switches to S-Video.

Displays or hides the menu.

Stops the current function. Pressing Esc while viewing a menu or
the online help displays the previous screen or menu. When the
image source is Computer, the Esc button acts as a mouse
right-click.

Synchronizes the computer’s graphic signal. Use these buttons to
adjust an overall image that is fuzzy or streaked, or to select menu
items during menu operations. Allows movement or selection of
a menu, if a menu is displayed.

Matches the projector’s internal clock to various computer
graphic signals (tracking adjustment).

Use these buttons to adjust an image with vertical fuzzy lines, or
to change numeric settings during menu operations.

Allows movement of a menu, if a menu is displayed.

2 « Using the Projector



Button Function

Enter Selects a menu option or the next menu/help screen. Pressing
Enter when no menu or help screen is displayed optimizes the
computer image.

Shift Pressing the shift and Keystone buttons at the same time
increases or decreases the sound volume.

— Keystone + Adjusts a trapezoid distorted image to normal.
—Volume + Adjusts the volume when used in conjunction with the Shift
button.

Selecting a Computer 2 or BNC Video Source

Comp2/BNC switch

>
B/B-Y BNC HD/Sync

When selecting a Computer 2 or BNC video source, be sure to toggle
the Comp2/BNC switch on the rear of the projector to the desired
. input source. The position of this switch determines which video
Lﬂi FixYourDLP.comMy, ,ce can be used, Computer 2 or BNC.

Selecting a Computer 2 or BNC Video Source
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Projector Status Lights

The lights on top of the projector tell you the projector’s operating
status.
power light
temperature light

projection lamp light

| /A3
TIN_"©

si|coo

Caution: A red light warns you if a serious problem occurs. See Chapter 6
for what to do if a warning light comes on.

Power Light

Light status Meaning
Steady orange Sleep mode. (The projector is plugged in, but not
projecting.)
Steady green Power and lamp are on.
Flashing green The projector is warming up. Allow about 30 seconds.
( jFix‘r’nurDLﬁmg orange The projector is cooling down.
Off. There. is.an.internal projector problem.
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Projection Lamp Light

Light status

Meaning

Orange and red
flashing alternately

Steady red
Flashing red

Off

Projection lamp needs replacing.

Projection lamp has burned out. Replace it to project images.
Problem with projection lamp or lamp power supply.

Lamp is functioning normally.

Temperature Light

Light status

Meaning

Flashing orange

Steady red

Flashing red

Off

Projector is too hot.

Projector has turned off automatically because of
overheating.

Problem with the cooling fan or temperature sensor.

The projector is functioning normally.

4 FixYourDLP.com
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Discount-Merchant.com (800) 281-8860
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
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Using the Projector Menus

& | FixYour
A

DLP.com

The eight projector menus allow you to control your projector from
either the remote control or the control panel:

O The Video menu controls the look and quality of the projected
image, and whether the image source is a computer or a video
source (for example, a VCR).

O The Audio menu controls audio features, such as the volume level,
treble, bass, and 3D sound.

0 The Effect menu lets you modify the special effects assigned to the

Effects buttons on the remote control and change the cursor speed.

83



O The Setting menu allows you to set or adjust such projector
options as the Picture in Picture (P in P) video source, blank
screen color, image source message prompt, A/V Mute display
option, and BNC input source.

O The User’s Logo menu lets you capture and store a custom logo
which may be used as a startup screen or with the A/V Mute
option.

O The Reset All menu lets you restore the factory defaults for all the
projector settings.

O The Advanced menu allows you to specify additional projector
settings, including a language, startup logo, color matching, video
signal, rear or ceiling projection, and the mouse/com port.

O The About menu provides information about H/V frequency,
lamp hours, and computer or video selection.

4 FixYourDLP.com
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Accessing the Main Menu

To display the Main menu, press the Menu button on the control
panel or the remote control. The Main menu displays.

Pesition S+ Adjustment
fiudin Tracking 1344
Ellect SYRC . 1]
detting Brightn
User*s Logo Comlras
Rezet &l1 REE 2+ Adjustment

fidvanced Sharpness - 0
fhhout Resolution:ibeto  idansal = Select
[ BanxAnn,/ ME13 1
Presel @+ Select
Re=ei 2+ Execute

Press the Menu button again to hide the menu.

As you select a menu, a submenu of options appears to the right. The
options available in some submenus vary, depending on whether the
current image source is the computer or a video source. The
illustration above shows a list of submenus for the Video menu when
the image source is the computer.

- ﬂ FixYou rDLP com
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Changing a Menu Setting

To change a menu setting:

1. Press the Menu button on the control panel or remote control to

display the Main menu.

2. Press the up or down arrows (control panel) or press up or down
on the Enter button (remote control) to scroll through the menu

choices.

& Power Help

up and
down
buttons

Computer An/mute Resize

Enter
button

- Keystone +

O C_O

Shift - Volume +

4 FixYourDLP.com

4

86 3 « Using the Projector Menus

EPSON

3




3. Press the Enter button to display a submenu.

& Power Help

Enter button

Computer aymute Resize ~ Video

Esc

~vacking

*Bupjoess

Sync-

- Keystone +

O CO

Shift - Volume +

EPSON

4. Press the up or down arrows (control panel) or up or down on the
Enter button (remote control) to scroll through the submenu
choices.

5.

Press either the left or right arrow buttons (control panel) or right
or left on the Enter button (remote control) to change a setting on
one of the submenus.

6. When you are finished changing settings, press Menu or Esc to

FiYourDLP.com go back to the Main menu. The changes are saved automatically.
ks ] Fix !
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The settings available in each of the menus are described below.

Note: Some options are limited to being enabled (turned on) or disabled
(turned off). Enabled options are indicated by a green light. Disabled
options are blank.

Video Menu (Image Source = Computer)

The Video menu lets you make adjustments to the projected image.
The following options are available when the image source is
Computer 1 or Computer 2.

Note: The computer must be connected and operating, and the image
source on the projector must be set to Computer 1 or Computer 2 for you to
access these menu options.

Menu item

Description

Position

Tracking

Sync

Select this item and then press the right arrow button (control panel)
or press right on the Enter button (remote control) to enter the screen
position adjustment mode. Then use the Enter button (remote
control) or up, down, left, and right buttons (control panel) to move
the screen position in the corresponding direction.

When you finish making adjustments, press the Esc button to return
to the Video menu.

Matches the projector’s internal clock to various computer graphic
signals. Adjust this setting to remove vertical lines from the image.

Synchronizes with the tracking signal sent from the computer. Adjust
this setting to correct fuzziness or screen flicker.

& 4 FixYourDLPcom
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Menu item

Description

Brightness

Contrast

Color

Sharpness

Resolution

Preset

Lightens or darkens the overall image. Increase brightness to lighten
an image, or decrease it to darken the image.

Adjusts the difference between light and dark areas. Increase the
contrast to make light areas lighter and dark areas darker. Decrease it
to minimize the difference between light and dark areas.

Adjusts the color balance of the input source.

Select this item and then press the right arrow button (control panel)
or press right on the Enter button (remote control) to enter the color

adjustment mode. Then use the Enter button or up and down buttons
(control panel) to select a color.

Next, use the Enter button or left and right buttons (control panel) to
adjust the selected color. Increase the color setting for more intense
color on the screen, and lower the setting for less intense color.

When you finish making adjustments, press the Esc button to return
to the Video menu.

Adjusts the sharpness of the screen image.

Specifies the video signal. In most cases, this setting should be left at
the Auto setting allowing the system to automatically detect the video
signal. If you want to specify a setting, however, you can select VGA,
SVGA, XGA, SXGA, UXGA, or TV/HDTV.

Allows you to save and recall up to five session computer settings
including the resolution, tracking, sync signal, and position.

4 FixYourDLP.com
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Menu item

Description

Reset

Returns all menu items to their initial factory defaults.

Select this item and then press the right arrow button (control panel)
or right on the Enter button (remote control) to display the
confirmation screen.

Select Yes and then press the Enter button to reset the menu.

If you change your mind, select No and then press the Enter button to
clear the confirmation screen without changing any settings.

Video Menu (Image Source = Video)

ke« FixYour

4

The Video menu lets you make adjustments to the projected image.
The following options are available when the image source is Video.

Note: The projector’s image source must be set to Video, and the video

source (such as a VCR, DVD player, or camcorder) must be connected and
operating for you to access these menu options. (For example, the projector
must actually be projecting the image from your video tape if you're using a

VCR.)

Menu item  Description

Position Select this item and then press the right arrow button (control panel)
or press right on the Enter button (remote control) to enter the screen
position adjustment mode. Then use the Enter button (remote
control) or up, down, left, and right buttons (control panel) to move
the screen position in the corresponding direction.
When you finish making adjustments, press the Esc button to return
to the Video menu.

DLP-eom
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Menu item

Description

Brightness

Contrast

Saturation
Tint

(NTSC only)
Sharpness

Reset

Lightens or darkens the overall image. Increase brightness to lighten
an image, or decrease it to darken the image.

Adjusts the degree of difference between light and dark areas.
Increase the contrast to make light areas lighter and dark areas
darker. Decrease it to minimize the difference between the lightest
and darkest areas of the image.

Adjusts the color density. Increase the saturation for darker and more
opaque color. Decrease it for lighter and less opaque color.

Adjusts the red-green color balance of the screen. Increase tint to add
more green, or decrease it to add more red.

Adjusts the sharpness of the screen image.

Returns all Video menu items to their initial factory defaults.

Select this item and then press the right arrow button (control panel)
or right on the Enter button (remote control) to display the
confirmation screen. Next, select Yes and then press the Enter button
to reset the Video menu.

If you change your mind, select No and then press the Enter button to
clear the confirmation screen without changing any settings.

4 FixYourDLP.com
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Audio Menu

Use the Audio menu to adjust the sound volume and quality of your

audio.

Menu item

Description

Volume

Treble

Bass

3D Sound

Reset

Adjusts the volume level for the speakers and audio-out terminal.

Increase the setting to raise the volume, or decrease it to lower the
volume.

Adjusts the treble tone of the speakers. (Press the right arrow button
on the control panel or press right on the remote’s Enter button to
increase the treble tone; press the control panel’s left arrow button or
left on the remote’s Enter button to decrease the treble tone.)

Adjusts the bass tone of the speakers. See Treble for details.

Adjusts the speakers’ stereo input. For a more expansive stereo
sound, increase this setting.

Returns all Audio menu items to their initial factory defaults.

Select this item and then press the Enter button to display the
confirmation screen. Next, select Yes and then press the Enter button
to reset the Audio menu.

If you change your mind, select No and then press the Enter button to
clear the confirmation screen without changing any settings.

4 FixYourDLP.com
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Effect Menu

Settin
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The Effect menu lets you modify the effects assigned to the remote
control Effects buttons.

Menu item Description

Cursor/Stamp  Selects the stamp you want to use as the cursor graphic and a zoom
rate.

Box Selects a box color.

Marker Selects the free line color and width.

Cursor Speed

Reset

Adjusts the cursor speed to Low, Middle, or High.

Returns all Effect menu items to their initial factory defaults.

Select this item and then press the Enter button to display the
confirmation screen. Next, select Yes and then press the Enter
button to reset the Effect menu.

If you change your mind, select No and then press the Enter button
to clear the confirmation screen without changing any settings.

g Menu

The Setting menu allows you to set or adjust various projector options.

Menu item Description
Keystone Adjusts a trapezoid distorted image to a 4:3 rectangle.
_D'Lﬁ"?_'c'"b inP Selects the image source (composite or S-Video) for the P in P

subscreen.

Effect Menu 93
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Menu item Description

Message Specifies whether a black screen, a blue screen, or a user logo
displays when the screen is blanked.

Prompt Displays a temporary message (computer or video) identifying the
image source.

A/V Mute Displays a blue, black, or user logo screen when the audio/video is
turned off.
BNC Specifies the format for BNC input. If the source is computer, select

RGB. If the source is video, select YcrCh. BNC will not display if the
optional Video I/F board is not installed.

DPMS Turns the lamp power on or off when there is no input source.
(Power Savings)

Reset Returns all Setting menu items to their initial factory defaults.

Select this item and then press the Enter button to display the
confirmation screen. Next, select Yes and then press the Enter
button to reset the Setting menu.

If you change your mind, select No and then press the Enter button
to clear the confirmation screen without changing any settings.

User’s Logo Menu

The User’s Logo menu allows you to capture and save a custom logo
which can be used as a splash screen or with the A/V Mute button.

4 FixYourDLP.com
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Capturing and Saving a Logo
Follow these steps to capture and save a logo:
1. Display the image (with the projector).

2. Press the Menu button on the control panel or remote control to
display the Main menu.

3. Press the down arrow (control panel) or press down on the Enter
button (remote control) to move to the User’s Logo option.

4. Press Enter (control panel or remote control) to display the User’s
Logo Setting window with the message “Do you use the present
image as a user logo?”

5. Select Yes and then press Enter (control panel or remote
control). A selection box displays over the image.

6. Use the arrow buttons on the control panel or the Enter button
on the remote control to select the area of the image you want to
use as the logo. Once you have selected the entire area, press Enter
(control panel or remote control).

7. When the message “Do you use this image?” appears on the screen,
select Yes and press Enter (control panel or remote control). If
you want to change the area selected, select No and repeat step 6.

8. Use the arrow buttons on the control panel or the Enter button
on the remote control to select a zoom rate, and then press Enter
(control panel or remote control).

4 FixYourDLP.com
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9. When the message “Do you save this user logo?” appears, select
Yes and then press Enter (control panel or remote control). If
you do not want to save the logo, select No.

Note: Saving the logo may take a few moments. Do not use the
projector or other sources (computer, video, speaker, etc.) while the
logo is being saved.

10. When you see the message “Saving the user logo is completed,”
press the Menu or Enter button to redisplay the Main menu.

Assigning the Logo to the A/V Mute Button
Follow these steps to assign the logo to the A/V Mute button:

1. Press the Menu button on the control panel or remote control to
display the Main menu (if not already displayed).

2. Select the Setting menu and then press the Enter button on the
control panel or remote control.

3. Select Blank from the A/V Mute options, and then highlight
User Logo.

4. Press the Menu button twice on the control panel or remote
control.

Now you can press the A/V Mute button on the control panel or the
remote control to display the user logo. Press it again to turn off the
logo.

4 FixYourDLP.com
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Reset All Menu

The Reset All menu lets you return all the projector settings to their
default values. Select Reset All and press the Enter button on the
control button or remote control to display the confirmation screen.
Select Yes to reset all the default settings or No to cancel.

Advanced Menu

The Advanced menu lets you set additional projector options.

Menu item Description

Language Selects the language to be used in the menus: English, Japanese,
French, German, Italian, Spanish, Portuguese, or Chinese.

Startup Screen Displays your user logo during the projector’s startup.

Color Matching Adjusts the whiteness of the screen. Positive color temperature
values provide a cold white; negative values provide a warmer
white. Press the right arrow button (control panel) or press right on
the Enter button (remote control) to increase the color temperature
value. Press the left arrow button (control panel) or press left on the
Enter button (remote control) to decrease the color temperature
value.

Video Signal Specifies the input image signal mode. You can select AUTO, NTSC,
NTSC 4.43, NTSC50, PAL, PAL N, PAL M, PAL 60 or SECAM.

Rear Projection Mirrors the projected image on its Y-axis (left-right). Selecting ON
turns mirroring on, while OFF turns it off (for a normal image). Turn
b JF'WUUTDLP-F_OW on this option when projecting from behind onto a transparent

-
.4 screen.
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Menu item

Description

Ceiling

Mouse/Com

Reset

Mirrors the projected image on its X-axis (top-bottom). Selecting ON
turns mirroring on, while OFF turns it off (for a normal image). Turn
this option on when the projector is mounted upside-down from the
ceiling.

Locks and unlocks the Mouse/Com port.

Select 1 to assign the wireless mouse control to the computer
connected to the Mouse/Com 1 port only.

Select 2 to assign the wireless mouse control to the computer
connected to the Mouse/Com 2 port only.

Selecting 1 <> 2 tells the projector to automatically switch wireless
mouse control whenever the input source computer is changed.

Returns all setting menu items to their initial factory defaults.

Select this item and then press the Enter button to display the
confirmation screen. Next, select Yes and then press the Enter
button to reset the Advanced menu.

If you change your mind, select No and then press the Enter button
to clear the confirmation screen without changing any settings.

DLP.com
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About Menu (Image Source = Computer)

When the image source is a computer, the About menu displays
information about the projector’s horizontal and vertical frequency,
lamp hours, and computer connection.

Menu item Description
Lamp Displays the number of hours the current lamp has been used.
Frequency Displays the projector’s horizontal and vertical frequency.

Sync Polarity
Sync Mode
Resolution

Refresh Rate

Displays the sync polarity of the computer.
Displays the sync mode of the computer.
Displays the output resolution of the computer video output.

Displays the refresh rate of the computer video output.

About Menu (Image Source = Video)

ke« FixYour
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When the image source is video, the About menu displays information

about the projector’s lamp hours and video signal.

Menu item Description
Lamp Displays the number of hours the current lamp has been used.
Video Signal Displays the input image signal mode.

DLP.com
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Using ELP Link IV

T he ELP Link IV software is a utility you can run from your desktop
or laptop computer to control projector features and draw special
graphics on your screen. You can also use the software to reconfigure
the special effects buttons on the remote control. This chapter
describes how to:

O Install the software

0O Start ELP Link IV

0O Customize the remote control Effects buttons
0 Control standard and special projector features

& ) FixYourDLP.com
= Bpor
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Installing the Software

ELP Link IV software can be used with the following operating
systems:

O Windows 3.1

0 Windows 95 or 98

O Windows NT 3.51 or 4.0

O Macintosh OS System 7.5 and OS System 8.x.

Connecting Needed Cables

Before installing the software, make sure the projector is properly
connected to your computer. See Chapter 1 for instructions on
installing the main and serial cables needed to use the ELP Link IV
software.

Installing the Software for Windows

Follow these steps to install ELP Link IV for Windows 3.x,
Windows 95 or 98, or Windows NT:

1. Turn on your computer and start Windows.
2. Insert the Projector Software CD into your CD-ROM drive.
3. If you have Windows 95, 98, or NT, click Start and then Run.

If you have Windows 3.x, in Program Manager click on the File

w4 FixYourDLP.comenu, then on Run.
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4. The Run dialog box appears. Type EAASETUP (substitute the
correct drive letter for your CD-ROM drive if it is not E), then
press Enter or click OK. You see the ELP Link IV Setup screen
listing the languages and options available for installation.

5. Select the language you want for running the software from the
dropdown list, and make sure ELP Link IV is checked. If you
don’t have Adobe® Acrobat® Reader on your system, also check
Acrobat Reader to install the program so you can view your online
manual. Then click OK.

6. After a moment, you see the ELP Link IV Welcome screen. Click
Next.

7. You see the Software License Agreement screen. Read the
agreement and click Yes.

8. Follow the instructions on the screen to select a directory or a
folder for the software. Then the Installer copies the ELP Link IV
files to your system.

9. When the installation is complete, click Finish.

10. If you selected to install Acrobat Reader, follow the on-screen
instructions to install it.

Note: If you ever select Unconnected and Execute from the Option
menu, always uncheck the setting before exiting ELP Link IV so the
program starts correctly the next time you use it.

4 FixYourDLP.com
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Installing the Software for a Macintosh

ke« FixYour
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Follow these steps to install the software for the Macintosh:

Note: You can not currently use the ELP Link 1V software with a Power
Macintosh G3 or iMac. Check with your dealer for future support.

1.

2
3.
4

8.

Insert the Projector Software CD into your CD-ROM drive.
Open the CD-ROM drive icon, if necessary.
Double-click the Installer icon.

You see a dialog box asking you to select a language for the
software. Select a language and click OK.

You see the Software License Agreement screen. Read the
agreement and click Accept.

You see the Program Install screen. Make sure ELP Link IV is
selected and, as necessary, Acrobat Reader, and then click OK.

You see the Folder to Install screen. Select the folder where you
want to install the software and click Install.

When the installation is finished, close the ELP Installation folder.

Note: If you ever select Unconnected and Execute from the Option
menu, always uncheck the setting before exiting ELP Link IV so the
program starts correctly the next time you use it.

DLP.com
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Starting ELP Link IV

Follow the steps in the appropriate section below to launch the
software. If you’re using the remote control as a mouse, use the Enter
button to position the cursor and click the Enter button to launch the
software.

Notes:

O If you have a Macintosh, your screens may look slightly different than
the screens in this chapter.

O If you have questions while working with ELP Link 1V, online help is
available by choosing the Help Topics command from the Help
menu.

Starting the Program from Windows

1. If you have Windows 3.x, double-click the ELP Link IV program
icon in the Windows 3.x ELP Link IV program group. If you have
Windows 95, 98, or NT, click Start, then select Programs,
ELP Link IV, and then click the ELP Link IV program icon.

The ELP Link 1V program icon appears minimized at the bottom
of your screen, or on the taskbar if you’re running Windows 95,
98, or NT.

4 FixYourDLP.com
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Note: If you see a prompt asking you to select a port or open the
software with the projector disconnected, it may be because the
projector is disconnected or is connected to an incorrect COM port. If
you want to run the software without the projector connected, select
Unconnected and Execute. If it is connected, click Select a
port and operate again. Then select the COM port you're using on
the next screen.

2. Click the minimized program icon. The ELP Link IV main
window appears.

Starting the Program on a Macintosh

1. Open the ELP Link IV folder.
2. Double-click the ELP Link IV icon.

If you're launching ELP Link IV for the first time, select COM Port
from the Option menu, then choose either the £ printer or

?< modem port (whichever port you connected the serial cable to).
Then open the Option menu and select Property Setting to display
the ELP Link IV main window.

Changing the COM Port Assignment

If you did not select the correct COM (communication) port when
setting up the software, or if you have changed the COM port to
which the projector is connected, you can change the COM port

setting from the ELP Link IV software.
4 FixYourDLP.com . . .
=" =1+ 20iNt to Select Port and Reconnect in the Options menu.

2. | Choose'a COM port from.the list that-appears.
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Customizing the Remote Control Effects
Buttons

In addition to the preprogrammed effects, you can also assign new
functions to the remote control Effects buttons from the ELP Link IV
main dialog box.
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Function Description and Usage

To assign a new function to an Effects button on the remote control,
click on the tab corresponding to the remote control Effects button
you want to assign, then choose a function for it from the dropdown
menu. Depending on the option selected, you can then make detailed
l;‘;l_;:‘:,‘j':""‘"’“'“f_[_“L_F_'_-‘F_*?'"‘selections such as color, shapes, width, and so on.

The table below-describes these functionsiand how to-use them.

Customizing the Remote Control Effects Buttons
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Note: To program new effects for the Effects buttons, the ELP Link 1V
software must be running. Once you have pressed an Effects button, you
can check the effect by using either your mouse or your remote control (if
you've set up the remote control to function as a mouse and the computer is
connected to the projector).

Function

Description and usage

Free Line

Line

Ellipse

Draws a free style line on the screen.

Press the Effects button assigned to this effect. Move the cursor
using the remote Enter button to draw the line. Press the Enter
button to set the line end position. To draw another line, move the
cursor away from the line you just created and press the Enter button
again to start the new line.

Draws a straight line on the screen.

Press the Effects button assigned to this effect. Then press the Enter
button once to define the line start position. Move the cursor using
the remote Enter button, and then the Enter button again to define
the line end position. To draw another line, move the cursor away
from the line you just created and press the Enter button again to
define the new line start position.

Draws an ellipse (oval) on the screen.

Press the Effects button assigned to this effect. Then press the Enter
button once to define the start position of the ellipse. Move the
cursor using the remote Enter button. Then press the Enter button
again to define the end position of the ellipse. To draw another
ellipse, move the cursor away from the one you just created and
press the Enter button again to define the start position for the new
ellipse.

4 FixYourDLP.com
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Function

Description and usage

Square

Bar

Stamp

Cursor
Change

Sound

Draws a square on the screen.

Press the Effects button assigned to this effect. Then press the Enter
button once to define the position of one corner of the square. Move
the cursor using the remote Enter button. Then press the Enter
button again to define the position of the opposite corner of the
square. To draw another square, move the cursor away from the one
you just created and press the Enter button again to define the start
position for the new square.

Creates a horizontal or vertical bar. You can use this function to
highlight a portion of the screen with a horizontal or vertical bar.

Press the Effects button assigned to this effect. Move the bar using
the remote Enter button. Press the Enter button to lock the bar in
place. To draw another bar, move the cursor away from the bar you
just created and press the Enter button again to lock the new bar in
place.

Leaves one or several copies of a pre-selected image on the screen.

Press the Effects button assigned to this effect. Use the Enter button
to place the cursor where you want the stamp to appear. Then press
the assigned Effects button to display the stamp. To draw another
stamp, move the cursor away from the stamp you just created and
press the Enter button again to lock the new stamp in place.

Changes the cursor shape.
Press the assigned Effects button to change the cursor shape.

Plays a selected sound effect.

Press the Effects button assigned to this effect. Click the Refer To
button to select the .wav file you want to play and click Open. Press
the assigned Effects button to play the sound.

4 FixYourDLP.con
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Function

Description and usage

Spotlight

Screen Clear

Key Macro

Creates a spotlight effect on the screen.

Press the Effects button assigned to this effect. Use the Enter button
to place the cursor where you want the spotlight to appear. Then
press the assigned Effects button to display the spotlight. To draw
another spotlight, move the cursor away from the spotlight you just
created and press the Enter button again to lock the new spotlight in
place.

Clears all Effects functions previously executed.
Press the assigned Effects button to clear the screen.

Types a pre-defined key sequence. This is useful when you often
need to type a sequence of characters into your computer.

Press the assigned Effects button to automatically type the key
sequence.

Note: To cancel or end a function, double-click with your mouse or press
the Enter button twice (if you're using the remote control as a mouse).

DLP.com
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Assigning Functions
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Each of the five Effects buttons is assigned a default function:
1 Change the mouse cursor to a stamp

2 Draw a box

3 Use a marker pen

4 Draw a freehand line

5 Clear the screen

If you want to assign a different function to a button, click the tab
(1-5) that corresponds to the button number and select a new function
from the dropdown list.

4 FixYourDLP.com

— ,.-;,-

Customizing the Remote Control Effects Buttons 111



112

Setting Effects Options

Once you have assigned functions to one or more Effects buttons, you
can specify detailed options for each function. You can also modify the
detailed options assigned to the pre programmed effects.

To set detailed options, click on the option you want to apply from the
options displayed below the Effects Type dropdown list. (The options
displayed depend on which functions are currently assigned to the
Effects buttons.)
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To test a setting, click the Test button and then click the left mouse
button to start and stop each setting. To end the test, click the right
mouse button. (If you are using the remote control as a mouse pointer,
use the Enter and Esc buttons, respectively.)

DLP.com
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The following table describes the options available for each function.

Function Options Description
Free Line Width Specify the line width, from 1 to 32 points.

Color Choose a color for the line.

Transparent Check this box to make the background text or image
visible through the line.

Line Width Specify the line width, from 1 to 32 points.

Grid Specify whether to have the line *“snap” to the corners
of a grid by entering the size of the sides of the box, in
pixels (dots).

Color Choose a color for the line.

Transparent Check this box to make the background text or image
visible through the line.

Ellipse Width Specify the line width, from 1 to 32 points.

Color Choose a color for the line.

Transparent Click this check box to make the background text or
image visible through the ellipse.

Fill Check this box to fill the ellipse with color.

Square Width Specify the line width, from 1 to 32 points.

Color Choose a color for the line.

Transparent Check this box to make the background text or image
visible through the square.

Fill Check this box to fill the square with color.

Track Shape

Check this box to round the corners of the square.

4 FixYourDLP.com
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Function Options Description
Bar Width Specify the line width, from 1 to 300 points.
Color Choose a color for the bar.
Direction Choose Horizontal or Vertical.
Transparent Check this box to make the background text or image
visible through the bar.
Stamp Click on the stamp to be used.

Cursor Change

4 FixYourDLEsumian

To create a new stamp, click New. The Stamp Edit screen appears,
allowing you to create a new stamp using the line, pencil, square,
ellipse, and color tools. To add the stamp to the collection, click Add.
To close the screen, choose Close from the File menu.

To edit a stamp, select it and then click Edit. After making your
changes, click Save. You have the option to save the stamp as a new
stamp, leaving the original intact, or to overwrite the existing stamp.
To close the screen, choose Close from the File menu.

To delete a stamp, select it and then click Delete. When the
confirmation message displays, click Yes.

Click on the cursor shape to be used.

To create a new cursor image, click New. The Cursor Edit screen
displays allowing you to create a new cursor using the line, pencil,
square, ellipse, and color tools. To add the cursor to the collection,
click Add. To close the screen, choose Close from the File menu.

To edit a cursor, select it and then click Edit. After making your
changes, click Save. You have the option to save the cursor as a new
cursor image, leaving the original intact, or to overwrite the existing
cursor. To close the screen, choose Close from the File menu.

To delete a cursor, select it and then click Delete. When the
confirmation message displays, click Yes.

Click Refer To to choose the desired .wav file. After selecting the file,
click Open. To test the sound, click the Play _button.
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Function Options Description

Spotlight Width Specify the line width, from 1 to 300 points.
Color Choose a color for the bar.

Transparent Check this box to make the background text or image
visible through the spotlight.

Screen Clear  No options available.

Key Macro Enter up to 16 characters, including combinations such as Ctrl + A, in
the Key to Enter field. The Backspace and Delete keys are also
recorded. After entering the desired key, press Enter.

Click the Delete All button to clear the current key assignment.

Note: Although you can save multiple sets of key assignments, only
one key set can be active at a time. Click the Enter button to save
more than one set of key assignments.

Assigning Functions to the Keyboard

If you want to execute an effect using your keyboard, follow these
steps:

1. Select the effect tab for which you want to assign function key
execution.

2. Click the mouse in the Shortcut key on execution field and
then press the function key you want to assign to this effect
(F2-F12).

4 FixYourDLP.com
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Saving and Recalling Effects Button Assignments

To save Effects button assignments, click Enter next to the Entry
Name dropdown list. The Registering Function Settings dialog
displays.

Hegisienng Feschon Ssethngs

Specify a name for the current settings and click OK.

To recall a saved set of assignments, select its name from the Entry
Name dropdown list.

To delete a set of assignments from the Entry Name menu, select its
name and then click Delete. When the confirmation message
displays, click Yes.

To exit without saving the settings, select Exit from the file menu.

4 FixYourDLP.com

4

116 4 + Using ELP Link IV



Controlling Projector Features

You can use the ELP Link IV software to control the following
features:

O

O
O
O

Changing projector settings
Changing the test pattern
Specifying an image gamma
Creating a user logo

Using the Quick Change Toolbar

To quickly change some basic projector settings, click one of the

toolbar buttons described below:

—

4 FixYourDLP.com
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‘— Power On, Off

‘ AV Mute
Freeze

Resize

Input Source - Video

Input Source - Computer

Controlling Projector Features
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Changing Projector Settings

1. Choose Projector Control from the Select Screen dropdown list.
You see the following window.
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2. Click the tab for the settings you want to adjust.

3. Change one or more of the following options.

- ﬁ FixYou rDL'P com
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Video Tab (Computer Input)

Option

Description

Tracking
Sync
Brightness
Contrast
Sharpness
Color
Position
Input

Resolution

Preset

Pattern
Display

Reset

Adjusts tracking to remove vertical lines.

Adjusts the sync (synchronization) to remove screen flicker.
Adjusts screen brightness.

Adjusts screen contrast.

Adjusts screen sharpness.

Adjusts the balance of red, green, and blue in the image.

Adjusts the horizontal and vertical screen position.

Selects the signal format. You can select AUTO, PAL, NTSC, a
specific resolution, or a preset setting. AUTO automatically adjusts
the image to the signal received.

Saves and recalls up to five different session settings (resolution,
tracking, sync signal and position). To save the current session
settings, choose the present number from the dropdown list and click

OK.

Displays the test pattern currently selected.

Resets all fields to their default values.

4 FixYourDLP.com
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Video Tab (Video Input)

Option

Description

Tracking
Sync.
Brightness
Contrast
Sharpness
Color

Tint
(NTSC only)

Input

Resolution

Preset

Pattern
Display

Reset

Adjusts tracking to remove vertical lines.

Adjusts the sync (synchronization) to remove screen flicker.
Adjusts screen brightness.

Adjusts screen contrast.

Adjusts screen sharpness.

Adjusts the balance of red, green, and blue in the image.

Adjusts the color tint.

Selects the signal format. You can select AUTO, PAL, NTSC, a
specific resolution, or a preset setting. AUTO automatically adjusts
the image to the signal received.

Saves and recalls up to five different session settings (resolution,
tracking, sync signal and position). To save the current session
settings, choose the present number from the dropdown list and click

OK.

Displays the test pattern currently selected.

Resets all fields to their default values.

4 FixYourDLP.com
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Audio Tab

Option

Description

Volume
Treble
Bass

3D Sound
Pattern
Display

Reset

Adjusts the sound volume.
Adjusts the treble tone.
Adjusts the bass tone.

Adjusts stereo sound effects. When you increase the number, the
stereo effect is enhanced.

Displays the test pattern currently selected.

Resets all fields to their default values.

¢ FixYourDLP.com
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Setting Tab

Option Description

Keystone Adjusts a trapezoid distorted image to normal.

Prompt Temporarily displays a prompt on the projector screen identifying
which source (computer or video) is providing the image.

DPMS Turns the lamp power on or off when there is no input source.

(Power

Savings)

PinP Selects the image source (composite or S-Video) for the P in P
subscreen.

BNC Specifies the input image signal mode as either RGB or Y, R-Y, B-Y.

Message Specifies whether a black screen, a blue screen, or a user logo
displays when the screen is blanked.

A/V Mute Displays a blue, black or user logo screen when the audio/video is
turned off.

Pattern Displays the test pattern currently selected.

Display

Reset Resets all fields to their default values.

4 FixYourDLP.com
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Advanced Tab

Option Description
Startup Displays your user logo during the projector’s startup.
Screen

Color Setting Adjusts the whiteness of the screen. Positive color temperature
values provide a cold white; negative values provide a warmer white.

Project From Specifies that you want to project from the Ceiling or Rear Projection.
Cursor Speed Specifies a cursor speed.

Video Signal Specifies the input image signal mode. You can select AUTO, NTSC,
NTSC 4.43, NTSC50, PAL, PAL N, PAL M, PAL 60 or SECAM.

Pattern Displays the test pattern currently selected.

Display

Reset Resets all fields to their default values.

About Tab

Option Description

Lamp Displays the number of hours the current lamp has been used.

Frequency Displays the projector’s horizontal and vertical frequency.
Sync Polarity Displays the sync polarity of the computer.

Sync Mode  Displays the sync mode of the computer.

DLP.comResolution Displays the output resolution of the computer video output.
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Option

Description

Pattern
Display

Reset

Displays the test pattern currently selected.

Resets all fields to their default values.

Gamma Tab

Option

Description

Select
Gamma

Pattern
Display

Reset

Specifies the desired gamma:

Gamma 1 Provides a dynamic and contrastive image.

Gamma 2 Provides an image between Gamma 1 and Gamma 3.
Gamma 3 Provides a natural image.

Displays the test pattern currently selected.

Resets all fields to their default values.

4 FixYourDLP.com
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Changing the Test Pattern

1. Choose the Test Pattern Setting option from the Option menu.
The following window appears:
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2. You can display a test pattern to verify that the projector is
working properly. Choose one of the following:

Color Image Displays a color bar test pattern.

Gray Scale Displays a gray scale test pattern.

Focus Pattern  Displays a character-based focus pattern.
User File Displays a bitmapped test pattern from the file

name specified. Either type the name or click
EYourDLP Refer to... to browse the hard disk for the file.
b i FixYourDLP.com
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The bitmap should be 1024 x 768 pixels
(PowerLite 7250 and 7350) or 800 x 600
pixels (PowerLite 5350).

3. Click OK to save the settings and close the Setting Test Pattern
screen.

4. Click Pattern Display on any Projector Control tab to display
the selected test pattern.

Specifying an Image Gamma

1. Click the Gamma tab on the Projector Control dialog. The
Gamma Setting window appears.
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2. Select the desired gamma:
Gamma 1 Provides a dynamic and contrastive image.
Gamma 2 Provides an image between Gamma 1 and Gamma 3.
Gamma 3 Provides a natural image.

3. Click Pattern Display to display the test pattern selected.

Saving Projector Setting Files

1. Choose the Save or Save As command from the File menu. The
Save As window appears.
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2. Enter a file name for the setting. The file will automatically be
given an .elp extension.

. 4FixYourDLP.com3. Click Save.
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Opening a Projector Setting File

1. Choose the Open command from the File menu. The Open
window appears.
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2. Locate the file (.elp) you want to open, and then click Open.

4 FixYourDLP.com
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Creating a User Logo

You can create or edit a logo from the Setting User Logo dialog box,
then save it to a file on your hard disk or download it to the projector.

1. Choose the Setting User Logo option from the Select Screen
dropdown menu. The User’s Logo Setting window appears.
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2. Choose the Open command from the File menu. The Open
dialog appears.

3. Locate and open a bitmap or logo (.bmp or .Igo) file. The selected
image appears in the display area.

4. To crop the image, click the Selecting Area button. The

Selecting User Logo Area window appears.
4 FixYourDLP.com
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5. Drag the mouse over the area you want to use as your logo.

6. Click OK to accept the changes. The User’s Logo window
reappears.

7. To increase or decrease the size at which the logo displays, select a
zoom percentage from the Zoom dropdown menu.

8. Choose the Save command from the File menu to automatically
save the logo to your hard disk. To save the logo under a different
file name, choose the Save As command.

Note: You must save logo files using the extension .Igo.

9. To download a logo file to the projector, choose the Sending
User Logo command from the Projector menu. When the

v FixYourDLP.cogpnfirmation message displays, click Yes.
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Creating Cursor/Stamps

You can create or edit a cursor or stamp from the Cursor/Stamp
Setting window.

1. Choose the Cursor/Stamp Setting option from the Select
Screen dropdown menu. The Cursor/Stamp Setting window
appears.

( FixYourDLP.com
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2. Click the Edit button. The Cursor/Stamp edit window appears.
e

EHLE
[# 5o TETIEIISLITTIND
l||:|-| vRirdd=tdafdalia
.l'-:'l. Ir AR EIR R 1I L ]
garm | |

arE || H :

| : 3

N i

&

e |

3. Create a new cursor/stamp using the pencil, line, square, ellipse,
and color tools.

4. Click Renewal to insert the cursor/stamp into the next available
spot in the Cursor/Stamp list.

5. Choose the Close command from the File menu to close the Edit
window and redisplay the Cursor/Stamp Setting window.

6. Choose the Save or Save As command from the File menu to
save your cursor/stamps.

7. To download a cursor/stamp file to the projector, choose the
‘ Sending Cursor/Stamp command from the Projector menu.
- | FixYourDLP.cofWhen the confirmation message displays, click Yes.
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Creating a New File
To create a new set of cursor/stamps, choose the New command from
the File menu. A blank Cursor/Stamp Setting window displays
allowing you to create a new set of cursors/stamps.

Opening a File
To open a cursor/stamp file:

1. Choose the Open command from the File menu. A standard
Windows Open dialog displays.

2. Select the .csp file and click Open.

3. To edit a cursor/stamp, click on it and then click Edit.

Exiting the Software

To exit and close the ELP Link IV software, choose the Exit command
from the File menu.

4 FixYourDLP.com
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Maintenance

Your projector needs little maintenance. You should keep the lens
clean because any dirt or smears appear on the screen. You also need to
periodically clean the air filter at the bottom of the projector. A
clogged air filter can block ventilation needed to cool the projector and
keep it from overheating.

The only parts you should replace are the lamp and air filter. If any
other part needs replacing, contact your dealer or a qualified service
person.

& i FixYourDLP.com
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Warning: Before you clean any part of the projector, turn off the projector
and unplug the power cord. Never open any cover on the projector, except
the lamp and filter covers. Dangerous electrical voltages in the projector
can injure you severely. Do not try to service this product yourself, except as
specifically explained in this User’s Guide. Refer all other servicing to
qualified service personnel.

Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the surface. Lightly
wipe the lens surface with a soft, dry, lint-free cloth. To remove dirt or
smears on the lens, moisten a soft cloth with an alcohol-based cleaner
and gently wipe the lens surface.

Cleaning the Projector Case

To clean the projector case, first unplug the power cord. To remove

dirt or dust, wipe the case with a soft, dry, lint-free cloth. To remove
stubborn dirt or stains, moisten a soft cloth with water and a neutral
detergent. Then wipe the case.

Do not use alcohol, benzene, thinner, or other chemical detergents.
These can cause the case to warp.

4 FixYourDLP.com
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Cleaning the Air Filter

Clean the air filter at the bottom of the projector after every 100 hours
of use. If it is not cleaned periodically, it can become clogged with
dust, preventing proper ventilation. This can cause overheating and
damage the projector. To clean the air filter, follow these steps:

1. Turn off the projector and unplug the power cable.

2. Turn the projector on its side so that the handle is on top and you
can access the filter easily.

Note: Standing the projector with the handle at the top keeps dust
from getting inside the projector housing.

3. Pull up on the filter cover tab to release the filter cover. Remove
the cover.
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4. The filter is attached to the inside of the filter cover. It is
recommended that you use a small vacuum cleaner designed for
computers and other office equipment to clean the filter. If you
don’t have one, use a dry, lint-free cloth.

If the dirt is difficult to remove or if the filter is torn, replace it.
Contact your dealer or call EPSON Accessories at (800) 873-7766
in the United States and Canada to obtain a new one.

5. Replace the filter cover when you’re done.

Replacing the Lamp

The projection lamp typically lasts for about 1500 to 2000 hours of
use. It is time to replace the lamp when:

O The projected image gets darker or starts to deteriorate.

O The projection lamp light is either red, or flashing orange and red
alternately.

0 The message LAMP REPLACE appears on the screen when the
projection lamp comes on (after about 1500 hours of use). To
maintain projector brightness and image quality, replace the lamp
as soon as possible.

Contact your dealer or call EPSON Accessories at (800) 873-7766 in
the United States and Canada for a replacement lamp. Request part
number ELPLPO9.

. Warning: Let the lamp cool before replacing it. Also, do not touch the glass
LM«’J FixYourDLES#iBn of the lamp assembly. Touching the glass portion of the lamp will
result inipremature lamp. failure.
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1. Turn off the projector and unplug the power cable.
2. Turn the projector over so you can access the lamp cover.

3. Use a screwdriver, coin, or similar object to loosen the two
retaining screws on the lamp cover. When the screws are loose, lift
off the lamp cover. (You cannot remove these screws from the
Cover.)

4. Use a screwdriver, coin, or similar object to loosen the two screws
holding the lamp unit in place. (You cannot remove these screws.)
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5. Lift up the handle and pull out the lamp unit.

200000000000

6. Gently insert the new lamp unit by lowering it into position.
Make sure it’s inserted securely. Tighten the screws on the new
lamp unit.

7. Replace the lamp cover and tighten the cover screws. (Make sure
the lamp cover is securely fastened. The projector turns itself off
if the lamp cover is open.)

4 FixYourDLP.com
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Transporting the Projector

The projector contains many glass parts and precision parts. If you
need to transport it, please follow these packing guidelines to prevent
damaging the projector:

O When shipping the projector for repairs, use the original
packaging material if possible. If you do not have the original
packaging, use equivalent materials, placing plenty of cushioning
around the projector.

0 When transporting the projector for business use, first put the
projector in a hard-shell carrying case (such as the optional
EPSON accessory case), then pack it in a firm box, using
cushioning around the case.

0 When you are hand-carrying the projector, be sure to store it in a
hard-shell or soft carrying case (such as the optional cases offered
by EPSON).

Note: EPSON shall not be liable for any damages incurred during
transportation.
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Troubleshooting
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DLP.com

T his chapter describes the problems indicated by the warning lights
and provides information on how to solve problems with the projector.
It is divided into the following sections:

O Problems with the projector. See this section if the projector is not
working and to find out what the warning lights mean.

0 Problems with the remote control. See this section if the projector
is not responding to remote control commands.

0 Problems with the screen image or sound. See this section if you
cannot project an image or if the screen image or sound is not
good.
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If you have a problem, check the appropriate section and follow all
suggestions that apply to your problem. You can also check the online
help by pressing the Help button on the control panel or remote
control. If none of the suggestions solves the problem, call your dealer
or contact EPSON as described on page 7.

Problems with the Projector

If you have problems with the projector, first turn it off and unplug it.
Then plug the power cord back in and turn on the projector. If this

does not solve the problem, check the warning lights at the top of the
projector. These lights alert you to problems with projector operation.

power light temperature light

A
mse

projector lamp light
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Light

Color

Meaning

Temperature  Flashing orange The projector is hot.

Red The projector is too hot and has turned off
automatically.

Flashing red There’s a problem with the cooling fan or
temperature sensor. Call a service
representative.

Projection Red or The lamp needs to be replaced. (See “Replacing
lamp flashing orange and red the Lamp” in Chapter 5 for instructions.)

Flashing red There’s a problem with the projection lamp,
lamp power supply, lamp fuse, or a circuit
malfunction in the projector.

Power Flashing green The projection lamp is warming up.

Flashing orange The projection lamp is off and the projector is
cooling down.

Green The projector is operating normally.

Orange The projector is in sleep mode.

Off The projector has turned off automatically
because of internal problems. Contact your
service representative.

DLP.com
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See the following pages for information on what to do when you see
these warning lights or encounter other specific problems with the
projector.

» The power light is flashing orange and you cannot turn on the
projector.

The lamp is cooling down. Wait until the light turns off and then turn
on the projector.

» The power light does not come on.

Turn off the projector, check that the power cable is connected
securely both at the power outlet and the projector, and press the
Power button again. Try removing and reseating the lamp.

» Projected images get darker or start to deteriorate, or the projection
lamp light is red.

Replace the projector lamp as described in Chapter 5.

» The temperature light is red.

The projector is overheating, which turns the lamp off automatically.
Let the projector cool for a few minutes, then turn it back on. Make
sure nothing is blocking the ventilation vents.

The air filter may be clogged. Clean it as described in Chapter 5 and
then let the projector cool for awhile.

If the projector continues to overheat after you clean the air filter, the
. problem may be caused by damage to the cooling fan or internal
7/ FixYourDLEIFeMTits. Contact a qualified service person.

Warning: Except as specifically explained in'this User’s. Guide, do hot
atternpt:togservice this product yourself.
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Problems with the Remote Control

» The projector doesn't respond to remote control commands.

Make sure the remote control is turned on. The RC switch, on the side
of the remote control, should be turned to the On position.

The remote control unit’s batteries may be low on power. Replace
them.

Make sure the projector’s mouse cable is securely connected to both
your computer’s mouse port and the projector’s main cable. See
Chapter 1 for details.

Make sure you selected the correct COM (communication) port for
the wireless mouse control when you set up the ELP Link IV software.
If necessary, you can change the COM port from the projector’s
Advanced menu. See page 97 for more information.

Light that is too strong, or certain types of fluorescent lighting may
affect the projector’s infrared receivers. Dim the ambient lighting and
turn off any fluorescent lighting. Move the projector out of direct
sunlight.

Turn off any nearby equipment that emits infrared energy, such as a
radiant room heater.

4 FixYourDLP.com
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Problems with the Image or Sound

» An image does not appear on the screen.

& 4 FixYourl
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Check that the Power light is on and the lens cover is off. Also make
sure the cables are installed correctly, as described in Chapter 1.

The correct image source may not be selected. Press the Computer
button on the control panel or the Comp1, Video, or BNC button
on the remote control to choose another image source.

Only part of the computer image is displayed.

If the computer’s output resolution setting is higher than 1024 x 768
on the PowerLite 7250 or 7350, or higher than 800 x 600 on the
PowerLite 5350, the image is resized. (See page 70 for information on
resizing.)

If the computer output is not compatible with this resizing, choose a
different display setting as follows.
Windows:

In Windows 3.x, use Windows Setup in the Main program group. In
Windows 95/98, right-click on the desktop, select Properties, click
the Settings tab, and use the dialog box to select the resolution you
want.

DLP.com
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Macintosh:

For a Macintosh, choose Control Panels under the Apple menu and
then choose Monitors. In the Monitors screen, choose Options and
make sure Macintosh Hi-Res Display or another 1024 x 768
(PowerLite 7250 or 7350) and 800 x 600 (PowerLite 5350) display is
selected. For supported display settings, see “Supported Monitor
Displays” on page 156.

You also may need to modify existing presentation files if you created
them for a different resolution. See your software manual for specific
information.

» The message NO SIGNAL is displayed.

An image source not connected to the projector is selected, the signal is
not being output from the computer, or the signal is not reaching the
projector. Make sure the connectors are securely attached to both the
projector and the image source. Then check that the image source is
selected correctly. If your projector is attached to a Macintosh, make
sure that the DIP switches on your Macintosh desktop adapter are set
correctly. (See your Macintosh documentation if you need
instructions.) When NO SIGNAL is displayed, you cannot access the
Video menu.

» A blank screen is displayed.

The computer signal cannot be interpreted by the projector. Verify the
display format (see page 156). When you see a blank screen, you

cannot access the projector menus.
4 FixYourDLP.com
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» The image or parts of the image are blurred or not in focus.

Adjust the Brightness and Contrast settings on the Video menu. If
you're viewing a computer image, also try adjusting the Tracking and
Sync buttons on the projector’s control panel.

There may be dirt or smears on the lens. Clean the lens as described on
page 136.

The image quality is poor on a laptop computer.

The video signal may be split between the computer and the projector.
If you notice a decline in the projected image quality when the image
is displayed simultaneously on your laptop computer and the
projector, turn off the laptop LCD display.

The colors of the image are not right.

The color balance may be incorrect. If you're displaying a computer
image, use the Color option in the Video menu to adjust the balance
of red, green, and blue. If you’re displaying video, adjust the
Saturation and Tint (NTSC only) settings on the Video menu.

Check your monitor’s color balance if you're displaying a computer
image.

DLP.com
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» There is no sound.

First check that the volume setting is not turned all the way down and
that the audio/video cable is securely attached to both the projector
and the audio source. Also, make sure that the A/V Mute button is not
enabled.

The wrong source is selected. Press the Computer button on the
control panel to select the proper source.
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Technical Specifications

General Type of display

Size of liquid crystal
panels

Lens

Resolution

Color reproduction

Brightness (typical)

& i FixYourDLP.com
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Poly-silicon Thin Film Transistor (TFT)

Diagonal: 1.3 inches (33.6 mm)
F=2.0-2.3, f=55-72 mm

PowerLite 5350: SVGA, 800 x 600 pixels
PowerLite 7250/7350: XGA, 1024 x 768
pixels

24 bit, 16.7 million colors

PowerLite 5350: 1500 lumens (ANSI)
PowerLite 7250: 1300 lumens (ANSI)
PowerLite 7350: 1600 lumens (ANSI)
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Image size Wide angle: 23 to 300 inches (at 3.9 to 40.6
feet distance)
Tele angle: 23 to 230 inches (at 5.1 to 54
feet distance)

Projection distance 3.18 to 54.8 feet (1.18 to 16.7 meters)
Projection methods Front, rear, upside-down (ceiling mount)

Internal speaker system 3 x 3 W stereo output
2 x 3 W 8 (ohm) speakers

Optical aspect ratio 4:3 (horizontal : vertical)

Zoom ratio 1:1.3

Tilt angle 0° to 12°

Supported video

interface standards NTSC, PAL, PAL-M, PAL-N, SECAM
Projection
Lamp Type UHE (Ultra High Efficiency)

Power consumption 150 W

Lamp life 1500-2000 hours (typical)

Part number ELPLPO9

4 FixYourDLP.com
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Remote
Control Range

Batteries

Mouse
Compatibility

Remote
IR Receiver
Mechanical Height
Width
Depth
Weight
Electrical Rated frequency

Power supply
Power consumption

Environmental Temperature

4 FixYourDLP.com
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32.8 feet (10 meters)
Alkaline AA (2)

Supports PS/2, USB, serial, ADB

Supports EPSON Remote IR Receiver,
10-foot cable (typical for rear screen
projection)

5.1 inches (129 mm)

11.8 inches (300 mm)

15.8 inches (400 mm)

13.81b (6.2 kg)

50/60 Hz

100 to 120 VAC, 2.4 A
200 to 240 VAC, 1.2 A

Operating: 200 W

Standby: 8.4 W

Operating: 41 to 104° F (5 to 40° C),
non-condensing

Storage: 14 to 140° F (-10 to 60° C),
non-condensing
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Humidity Operating: 20 to 80% RH,
non-condensing

Storage: 10 to 90% RH,
non-condensing

Safety United States FCC Part 15J Class B
UL1950 Rev. 3
Canada DOC SOR/88-475

CSA C22.2 No. 950 Rev. 3

Supported Monitor Displays
The following table lists the display formats supported by the

projector:
Mode Resolution Frequency Dot
H(KHz)/V(Hz) (MHz)
VGACGA 640 x 400 31.46/70 25.175
VGAEGA 640 x 350 31.46/70 25.175
NEC400 640 x 400 24.83 / 56.65 21.053
VGA60 640 x 480 31.469/59.94 25.175
VGAT72 640 x 480 37.861/72.809 315
VGA75 640 x 480 375175 315
VGA85 640 x 480 48.269 / 85.008 36

4 FixYourDLP.com
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Mode Resolution Frequency Dot
H(KHz)/V(Hz) (MHz)
SVGA56 800 x 600 35.156 / 56.25 36
SVGA60 800 x 600 37.879/60.317 40
SVGA72 800 x 600 48.077/72.188 50
SVGAT75 800 x 600 46.875/75 49.5
SVGA85 800 x 600 53.674 / 85.061 56.25
XGA43i 1024 x 768 35.522 / 86.958 44.9
XGAB0 1024 x 768 48.363 / 60.004 65
XGA70 1024 x 768 56.476 / 70.069 75
XGAT75 1024 x 768 60.023 / 75.029 78.75
XGA85 1024 x 768 68.677 / 84.997 94.5
SXGA1_70 1152 x 864 63.851/70.012 94.5
SXGA1_75 1152 x 864 67.5/75 108
SXGA1_85 1152 x 864 77.094 / 84.002 121.5
SXGA2_60 1280 x 960 60/ 60 108
SXGA2_75 1280 x 960 75175 126
SXGA2_85 1280 x 960 85.938 / 85.002 148.5
SXGA3_43i 1280 x 1024 46.433/86.871 78.75
SXGA3_60 1280 x 1024 63.981 / 60.02 108
SXGA3_75 1280 x 1024 79.976 / 75.025 135
SXGA_85 1280 x 1024 91.146 / 85.024 157.5
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Mode Resolution Frequency Dot

H(KHz)/V(Hz) (MHz)
UXGA48i 1600 x 1200 62.5/96.080 135
UXGAG0 1600 x 1200 75/ 60 162
UXGAG5 1600 x 1200 81.25/65 175.5
UXGAT70 1600 x 1200 87.5/70 189
UXGAT75 1600 x 1200 93.75/75 202.5
MACLC13 640 x 480 34.975/66.62 31.33
MACII13 640 x 480 35/66.67 30.24
MAC16 832 x 624 49.725/74.55 57.28
MAC19-60 1024 x 768 48.193/59.28 64
MAC19 1024 x 768 60.241/74.93 80
MAC21 1152 x 870 68.682 / 75.062 100
HDTV480P 720 x 483 31.469/59.940 27
(ANSI/SMPTE)
HDTV480P 704 x 480 31.469 /59.940 27
(ATSC)
HDTV480I 720 x 487 15.734 /59.940 135
(ANSI/SMPTE)
HDTV480I 704 x 480 15.734 /59.940 135
(ATSC)
HDTV720P 1280 x 720 44.955 / 59.940 74.176
(SMPTE)
HDTV1080I 1920 x 1080 67.433/ 59.940 148.352
NSI/SMPTE
- Fix‘r’nurDL(!é.com :
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Mode Resolution Frequency Dot
H(KHz)/V(Hz) (MHz)
HDTV1080I 1920 x 1080 33.716 / 59.940 74.176
(ANSI/SMPTE)
NTSC (SXGA) 1366 x 438 15.734 / 60 28.486
NTSC (XGA) 1024 x 438 15.734 /1 60 2.890
PAL (SXGA) 1366 x 512 15.625 /50 28.846
PAL (XGA) 1024 x 512 15.625/ 50 21.154
SECAM (SXGA) 1366 x 512 15.625/ 50 28.846
SECAM (XGA) 1024 x 512 15.625/ 50 21.154

Note: The frequencies of some computers may not allow the

image to be displayed correctly.

DLP.com
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Computer 1 and 2 and Computer Out connector pin assignments

The Computer 1, 2, and Computer Out connectors are female video
RGB, 15-pin micro-D-style connectors. Here are the pin assignments:

Input pin  Computer Out Computer 1 and 2
connector signals connector signals

1 Red out / red video Red video
2 Green out / green video Green video
3 Blue out / blue video Blue video
4 Reserved Monitor (ID bit 2)
5 GND GND
6 GND Red video GND
7 GND Green video GND
8 GND Blue video GND
9 Reserved +5V
10 GND Synchronous GND
11 Reserved Monitor (ID bit 0)
12 Reserved SDA
13 Horizontal sync Horizontal sync
14 Vertical sync Vertical sync

k¥ FixYourDLP.com
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Glossary
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Brightness. The balance of light and dark shades in an image.

Component video. The recording and transmission of video using
separate red, green, blue and synchronization signals.

Composite video. A type of video signal that encodes picture,
luminance, and synchronization information so it can be carried in one
signal.

Contrast. A measure of the tonal differences between the highlights
and shadows of an image. In a high-contrast image, light areas are very
bright and dark areas are very dark, with relatively few levels of gray
between white and black. Contrast is decreased by adding grays.

NTSC. A 525-line video broadcast format developed by the National
Television Standards Committee. NTSC is widely used in North
America, Mexico, and Japan.

DLP.com
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PAL (Phase Alternation by Line). A 625-line video broadcast format
used in Western Europe, India, China, Australia, New Zealand, and
parts of Africa.

Point. A measurement of drawn or printed objects. One point equals
1/72 inch.

Resolution. A measure of the amount of detail contained in an image.
Resolution can be measured in dots per inch or in pixels. Image
sharpness and clarity improve as resolution increases.

RGB. A type of color scheme that defines color as percentages of red,
green, and blue.

S-Video. A type of video signal used in S-VHS videotape formats. It
transmits luminance and color separately.

SECAM (System Electronique pour Couleur Avec Memoire). A
625-line TV system used in France, Eastern Europe, Russia, and parts
of Africa.

Sleep mode. A power-saving feature in which the projection lamp is
turned off when the projector has not been used for 30 minutes. In
sleep mode, only a minimum amount of the projector’s circuitry
remains on.

SVGA. Super Video Graphics Array. SVGA provides higher resolution
than VGA.

SXGA. Super Extended Graphics Array. SXGA provides higher
resolution than XGA.

DLP.com
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VGA. Video Graphics Array. A high-resolution display adapter that
provides a variety of video modes.

XGA. Extended Graphics Array. IBM’s next generation display
adapter, XGA provides higher resolution than VGA.

UXGA. Ultra Extended Graphics Array. UXGA provides higher
resolution than SXGA.
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Index

Numerics
3D Sound, 92, 121

A

About menu, 99

Accessories, 4t0 5, 9

Air filter, cleaning, 137 to 138

Amplification, 56 to 57

Anti-theft device, 17

Audio
connecting desktop, 28, 42
connecting laptop, 33
connecting PowerBook, 51
menu, 83, 92
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B
Bar function, 114
Bass, 92, 121
Batteries, installing, 18 to 19
BNC Format, 94, 122
Brightness, 89, 91, 117, 119, 120, 153, 161
Buttons
control panel, 77, 86, 95
customizing the Effects buttons, 107 to
116
remote control, 72 to 75, 86, 95

C

Cables, 4t0 5, 14 to 17

Camcorder, adjusting the projected image,
90to 91



Case, cleaning, 136
Ceiling, hanging the projector from, 94
Cleaning

air filter, 137 to 138

lens, 136

projector case, 136
Color

balance, 91, 119

menu option, 89

saturation, 91, 119
COM port, changing, 106
CompuServe, 7
Computer connector pin assignments, 160
Computer, adjusting projected image for,

881t0 91
Connecting projector

to a desktop Macintosh, 34 to 42

to a desktop PC, 22 to 28

to a high-end workstation, 52

to a laptop PC, 29 to 33

to a PA system, 56 to 57

to a PowerBook, 43 to 51

to a video source, 52 to 55

to an external speaker, 56 to 57
Connector pin assignments, 160
Contrast, 89, 91, 117, 119, 120, 161
Control panel
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Index

functions, 77

using, 77 to 79
Cursor, changing shape, 109, 114
Customizing the Effects buttons, 107 to 115

D

DIP switches, 36, 45

Display formats, supported, 156 to 159

Distance from projector to screen, 19 to 20,
62 to 67,

Drawing screen graphics, 108 to 110, 113

E
Effects buttons
assigning functions, 111
customizing, 107 to 115
function options, 113 to 115
functions list, 107 to 110
saving and recalling assignments, 116
Electrical specifications, 155
Ellipse, 108, 113
ELP Link 1V software
installing, 102 to 104
launching, 106
Environmental specifications, 155
EPSON support, 8
External speakers, 56 to 57
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FaxAdvice, EPSON, 8

Features, 1 to 2

Feet, raising or lowering, 69

Focusing, 68 to 69

Formats, supported display, 156 to 159
Freeze button, 75

FTP site, EPSON, 7

G
Graphics, drawing screen, 108 to 109, 113
to 114

H

Help, EPSON, 8

High-end workstation, 52
Humidity requirements, 155

I
Image
adjusting position, 68 to 69, 88, 90, 119
adjusting quality, 88 to 91
leaving a copy on the screen, 109
problems, 148 to 151
resizing, 70
size range, 154
Image Gamma, 126 to 127
AFedlreceilVeisoriocation, 62
Iﬁff/alling batteries, 18 to 19

Installing the ELP Link IV software, 102 to
104
Internet, 7

K
Key Macro function, 110, 115
Keystone, 64, 69, 79

L
Lamp
light, 80 to 81, 144 to 145
replacing, 138 to 140
specifications, 154
Language menu option, 97
Laptop, connecting to, 29 to 33, 43 to 51
Launching the ELP Link IV software, 106
Lens, cleaning, 136
Lights, status, 80 to 81, 144 to 146
Line function, 108, 113
Logo, creating, 129 to 132
Long throw zoom lens, 66 to 67
Lumens, 153

M
Macintosh
connecting projector to, 34 to 51
installing software, 104
Mechanical specifications, 155



Menus

accessing, 85

Audio, 83, 92

Options, 83, 93

Video, 83, 88 to 91
Monitors, supported, 156 to 159

@)
Options for the projector, 4to 5
Options menu, 83, 93

P
PA system, 56 to 57
Pin assignments, connector, 160
Pointer button, 75
Positioning the projector, 19 to 20, 62 to 67
Positioning the screen image, 68 to 69, 88,
90, 119
Power
button, 75to 77
consumption, 155
light, 80, 144 to 146
supply, 155
PowerBook, connecting projector to, 43 to
51
Projection lamp light, 80 to 81, 144 to 145
Projector
C._ #Ctingu 1L FocbT
disednce to screen, 20, 63 to 67
focusing,.68.t0.69

Index

hanging from the ceiling, 94, 98
lamp specifications, 154
parts identified, 62
positioning, 19 to 20, 62 to 67
positioning the screen image, 68 to 69,
88, 90, 119
problems, 144 to 146
setting up, 13 to 57
status lights, 80 to 81, 144 to 146
turning on and off, 58 to 59
unpacking, 14 to 16
using the Quick Change Toolbar, 117
Projector case, cleaning, 136
Projector Setting window, 117
Prompt menu option, 93

Q
Quick Change Toolbar, 117

R
Rear projection, 97, 123
Remote control
buttons, 72 to 75, 86, 95
customizing the Effects buttons, 107 to
116
functions, 75
problems, 147
specifications, 155
using, 3, 72to 75
Replacing the lamp, 138 to 140



Reset All menu, 97
Resize button, 70
Resolution, 153, 162

S
Safety instructions, 9to 11
Screen image, problems, 148 to 151
Sleep mode, 3, 71, 162
Software
installing, 102 to 104
launching, 106
using, 130, 132
Sound problems, 150
Speakers
adjusting the tone, 92, 121
adjusting the volume, 92, 121
connecting projector to, 56 to 57
Specifications
electrical, 155
environmental, 155
general, 153 to 154
lamp, 154
mechanical, 155
remote control, 155
safety, 156
Stamp function, 109, 114
Status lights, 80 to 81, 144 to 146
. Hbirlciedhticaln8
S¥/ideo signal. 16, 162

Sync, 88, 119, 120

T
Temperature
light, 81, 144 to 146
requirements, 155
Test pattern
changing, 125
displaying, 119, 120
Tint, 91
Tone, adjusting, 92, 121
Toolbar, using, 117
Tracking, 88, 119, 120
Treble, 92, 121
Troubleshooting

image and sound problems, 148 to 151

projector problems, 144 to 146
remote control problems, 147

Turning the projector on and off, 58 to 59

U
Unpacking projector, 14 to 16
User logo, creating, 129 to 132

\Y,

VCR, adjusting the projected image, 90 to

91, 99
VGA, 163



Video
adjusting projected image for, 90
jacks, 54
menus, 83, 88 to 91

Video source, connecting projector to, 52 to
55

Volume, 92, 117, 121

w
Warning lights, 80 to 81, 144 to 146

4 FixYourDLP.com

4

Index

Workstations, connecting projector to, 52
World Wide Web, 7

X
XGA, 163

Z
Zoom ratio, 154
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Disclaimer

This user manual is provided as a free service by FixYourDLP.com. FixYourDLP is in no way responsible
for the content of this manual, nor do we guarantee its accuracy. FixYourDLP does not make any claim
of copyright and all copyrights remain the property of their respective owners.

About FixYourDLPcom
FixYourDLP.com (http://www.fixyourdlp.com) is the World’s #1 resource for media product news,
reviews, do-it-yourself guides, and manuals.

Informational Blog: http://www.fixyourdlp.com
Video Guides: http://www.fixyourdlp.com/guides

User Forums: http://www.fixyourdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.fixyourdlp.com/counterfeits

Sponsors:

RecycleYourLamp.org - Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research - The trusted 3rd party lamp research company:
http://www.lampresearch.com

Discount-Merchant.com - The worlds largest lamp distributor:
http://www.discount-merchant.com

' FixYourDLP.com
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